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Before You Begin 

The Microsoft® LAN Manager User's Guidefor MS-DOS® is for new and experienced 
users of Microsoft LAN Manager for the MS-DOS operating system. It describes how to 
use LAN Manager commands for the Enhanced and Basic versions and the LAN Manager 
Screen for the Enhanced version. 

This manual assumes that you know how to use a personal computer and that you are 
familiar with MS-DOS. If you are not familiar with MS-DOS, see your MS-DOS 
manual(s). 

Before using this manual, you should read Getting To Know Microsoft LAN Manager to 
learn terms and concepts specific to a local-area network and to LAN Manager. 

How To Use This Manual 
This manual is divided into three parts: 

Part 1, "Overview" 
Part 1 explains how a local-area network works and the differences between the two 
versions of LAN Manager for MS-DOS-Enhanced and Basic. You should read this 
part if you are not familiar with LAN Manager. 

Part 2, "LAN Manager Enhanced" 
Part 2 describes how to use LAN Manager Enhanced to perform network tasks from 
the LAN Manager Screen and from the command line. It explains how to use shared 
directories and shared printers, send messages to other network users, and customize 
your workstation. It also provides reference information for each LAN Manager 
Enhanced command typed at the MS-DOS prompt. You should read this part to learn 
how to use LAN Manager Enhanced. 

Part 3, "LAN Manager Basic" 
Part 3 describes how to use LAN Manager Basic to perform network tasks from the 
command line. It explains how to use shared directories and shared printers and 
provides reference information for each LAN Manager Basic command. You should 
read this part to learn how to use LAN Manager Basic. 

1 
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Notational Conventions 
This manual uses different type styles and special characters for different purposes: 

Convention 

Bold 

Italic 

Monospace 

FULL CAPS 

SMALL CAPS 

KEY+KEY 

{braces} 

[brackets] 

I (vertical bar) 

... (ellipsis) 

<Command> 

Use 

Represents commands, command options, and file entries. 
Type the words exactly as they appear, for example, 
net use. 

Introduces new terms and represents variables. For 
example, the variable computername indicates that you 
supply the name of a workstation or server. 

Represents examples, screen displays, program code, and 
error messages. 

Represent filenames and pathnames in text. You can, 
however, type entries in uppercase or lowercase letters. 

Represent key names (such as CTRL or F2). 

Indicates that you must press two keys at the same time. 
For example, "Press CTRL+Z" means to hold down CTRL 
and press Z. 

Enclose required items in syntax statements. For example, 
{yes I no} indicates that you must specify yes or no when 
using the command. Type only the information within the 
braces, not the braces themselves. 

Enclose optional items in syntax statements. For example, 
[password] indicates a password may be needed with the 
command. Type only the information within the brackets, 
not the brackets themselves. 

Separates items within braces or brackets. For example, 
{/hold I Irelease I Idelete} indicates that only one of the 
three options can be used. 

In syntax statements, indicates that you can repeat the 
previous item(s). For example, Iroute:devicename[, ... ] 
indicates that you can specify more than one device, 
putting a comma between the devicenames. 

Indicates a command button to be chosen within a dialog 
box. 
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(continued) 

Convention Use 

Indicates the procedure for performing a task using the 
LAN Manager Screen. 

Command 
Line 

Indicates the procedure for performing a task using LAN 
Manager commands at the MS-DOS prompt. 

Finding Further Information 
This manual is written for LAN Manager for MS-DOS users. In addition to this manual, 
the LAN Manager manual set includes the following: 

Getting To Know Microsoft LAN Manager 
Gives first-time network users an introduction to local-area networks and to LAN 
Manager. 

Microsoft LAN Manager User's Guide for MS OS/2 
Provides guide and reference information about using LAN Manager on Microsoft 
Operating System/2 (MS® OS/2) workstations. 

Microsoft LAN Manager Installation Guide 
Provides information about installing LAN Manager software and using the Setup 
program to configure workstations and servers. 

Microsoft LAN Manager Administrator's Guide 
Provides detailed information about administering a LAN Manager network. 

Microsoft LAN Manager Administrator's Reference 
Provides reference information about LAN Manager commands and utilities for 
MS OS/2 computers, and about the LAN Manager program directory and initialization 
file. 

Microsoft LAN Manager Network Device Driver Guide 
Provides information about network device drivers that can be used with LAN 
Manager. 

Microsoft LAN Manager Programmer's Reference 
Provides information about LAN Manager application program interfaces (APls). 
(This manual is optionally available.) 

Quick references are also available for users and administrators. 





Par t 1 
Overview 

Part 1 introduces LAN Manager for MS-DOS. It describes how a local-area network 
works and explains the differences between the two versions of LAN Manager for 
MS-DOS-Enhanced and Basic. 
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Chapter 1 

Using LAN Manager with MS-DOS 

This chapter describes LAN Manager for MS-DOS and explains the differences between 
LAN Manager Enhanced and LAN Manager Basic. Read this chapter to gain a general 
understanding of LAN Manager for MS-DOS. To learn specifics about each version of 
LAN Manager for MS-DOS, see Part 2, "LAN Manager Enhanced," or Part 3, "LAN 
Manager Basic." 

How LAN Manager Works 
LAN Manager expands the features of MS-DOS to let your computer join a local-area 
network. A local-area network is a group of personal computers that can communicate 
with each other and share resources. 

A LAN Manager network is comprised of workstations and servers. Workstations are 
computers that can use information and equipment on the network. Your workstation runs 
MS-DOS; others on the network can run MS-DOS or MS OS/2. Servers are computers that 
control information and equipment that workstations use. A server can also be used as a 
workstation. A server runs MS OS/2. 

Information and equipment are made available to you and other network users through a 
process called sharing. The servers on a network share resources-directories and 
printers-with network users at workstations. 

You can use a shared resource by connecting your workstation to the server sharing the 
resource. The resource is then used as though it were attached to your computer, even if it 
is actually located down the hall or in another part of the building. 

The person who maintains the network is called an administrator. A network can have one 
or more administrators. Administrators share resources at servers and handle network 
security. If you need a password to connect to a shared resource or if you have trouble 
using your workstation, ask your administrator for help. 

9 
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Different Versions of LAN Manager for MS-DOS 
Two versions of LAN Manager for MS-DOS-Enhanced and Basic-are available for a 
workstation. If you are not sure which version your computer is running, ask your 
administrator. 

The Enhanced Version 
LAN Manager Enhanced features the LAN Manager Screen, a full-screen interface that 
lets you use shared resources and perform other network tasks. With LAN Manager 
Enhanced, you can 

• Use LAN Manager Screen menus and dialog boxes, or type LAN Manager Enhanced 
commands from the MS-DOS command line, to perform network tasks 

• Get online help with the LAN Manager Screen and command-line commands 

• Display the contents of printer queues and control print jobs in a queue 

• Move and copy files between any two directories on the network 

• Send messages to and receive messages from other users 

• Create a customized set of network connections- called a profile-which lets you 
connect to several resources with one command 

To learn how to use LAN Manager Enhanced, see Part 2, "LAN Manager Enhanced." 

The Basic Version 
LAN Manager Basic is used by typing commands at the MS-DOS prompt. With LAN 
Manager Basic, you can 

• Add your computer to a network 

• Use shared disk drives, directories, files, and printers 

• Get online help 

• Display the contents of printer queues 

• Pause and continue connections to network resources 

To learn how to use LAN Manager Basic, see Part 3, "LAN Manager Basic." 
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Working with Other Network Products 
LAN Manager software works with products outside the LAN Manager family. For 
example, computers running MS-Net or XENIX® network software can share resources 
with LAN Manager workstations. Figure 1.1 shows a network with mixed products. 

MS® OS/2 
LAN Manager 

Server 

MS-Net 
Server 

MS OS/2 
LAN Manager 

Server 

XENIX® 
Server 

MS OS/2 
Workstation 

MS-DOS® 
LAN Manager 

Basic 

MS-DOS 
LAN Manager 

Enhanced 

MS-Net 
Workstation 

PC LAN 
Workstation 

Figure 1.1 Local-area network with mixed products 





Par t 2 
LAN Manager Enhanced 

Part 2 explains how to use a LAN Manager Enhanced workstation to perform network 
tasks. It describes how to start and stop the workstation, log on to and log off from the 
local-area network, get help, and use the LAN Manager Screen. It also describes 
procedures for using shared resources, sending and receiving messages, and customizing 
your workstation. Additionally, LAN Manager Enhanced commands typed at the 
MS-DOS prompt are explained in detail. 





LAN Manager Enhanced 
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6 Customizing Your Workstation ................... 63 
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Chapter 2 

Getting Started 

This chapter introduces LAN Manager Enhanced, and explains how to start your 
workstation and log on to the network. 

The LAN Manager Screen is described, with instructions for moving around the screen 
using the keyboard and the mouse. Information is provided about getting help with 
commands and error messages, viewing network resources, and understanding user 
accounts. This chapter ends with an explanation of how to exit the LAN Manager Screen 
and quit LAN Manager Enhanced. 

If LAN Manager Enhanced hasn't been installed on your computer, contact your 
administrator. 

The procedures in this chapter are described using the LAN Manager Screen, followed by 
the equivalent command you type at the MS-DOS prompt. Each LAN Manager Enhanced 
command is discussed in detail in Chapter 7, "Enhanced Command Reference." 

Features of LAN Manager 
This section introduces some of the features of LAN Manager Enhanced, including the 
LAN Manager Screen, commands, online help, profiles, and services. 

The LAN Manager Screen 
The LAN Manager Screen is a menu-oriented, full-screen interface that allows you to use 
LAN Manager without memorizing command syntax. Most network tasks can be 
performed with the LAN Manager Screen. The LAN Manager Screen is displayed in 
Figure 2.1. 

17 
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Command-Line Commands 
In addition to using the LAN Manager Screen to perfonn network tasks, you can also type 
LAN Manager commands at the MS-DOS prompt. (This can be done by exiting the LAN 
Manager Screen.) 

Chapters 3-6 describe procedures for performing network tasks with the LAN Manager 
Screen, followed by the equivalent command-line command. For tasks that cannot be 
performed using the LAN Manager Screen, the command-line command is discussed in 
more detail. For detailed information about all typed LAN Manager Enhanced commands, 
see Chapter 7, "Enhanced Command Reference." 

Online Help 

Profiles 

Services 

Help is available both from the LAN Manager Screen and from the MS-DOS command 
line. The LAN Manager Screen provides context-sensitive help on most topics. From any 
dialog box, you can get help with the dialog box as well as many associated functions and 
terms. 

LAN Manager allows you to make connections to shared resources, then save a record of 
these connections in a file called a profile. You can use this profile to automatically 
reestablish the connections. 

Connections specified in a profile can replace existing connections or be added to them. 
For information about creating and using profiles, see Chapter 6, "Customizing Your 
Workstation. " 

A service is a program that perfonns one of the major functions of LAN Manager. Major 
services are the following: 

Workstation 
The Workstation service is the primary service for a workstation. If the Workstation 
service isn't running, no other service can run. Once you start the Workstation service 
and log on, you can use the network and gain access to shared resources. 

Messenger 
The Messenger service lets you receive messages from other network users or from 
LAN Manager Enhanced (for example, when your print job has been printed). You 
can use message logging to save these messages in a file. For more information about 
the Messenger service, see Chapter 5, "Sending and Receiving Messages." 
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Netpopup 
The Netpopup service displays messages on your screen as they arrive from other 
users or from LAN Manager Enhanced. For more information about the Netpopup 
service, see Chapter 5, "Sending and Receiving Messages." 

Starting LAN Manager Enhanced 
Starting LAN Manager Enhanced involves two separate tasks: 

• Starting the Workstation service 

• Logging on to the network 

When you start the Workstation service, software that lets you use shared resources and 
send and receive messages is loaded into your computer's memory. 

Logging on identifies you on the network and establishes you as the user of the 
workstation. When you log on, you supply your username and password, which identify 
you as a member of a domain. A domain is a group of computers and users on the network. 

Domains keep the network organized and simplify administration. They have names, just 
like workstations and servers. When you log on, you automatically log on in the 
workstation domain. You don't need to specify the workstation domain name; it is 
specified in the LAN Manager Enhanced software. You can override the workstation 
domain by supplying the name of a different domain in which to log on. This domain is 
called the logon domain. 

A server called the primary domain controller or a logon server verifies that you are 
allowed to log on in a domain. On this server, the administrator maintains a record of user 
accounts, which define the hours that each user can log on and the access that he or she 
has to resources in the domain. 

Starting the Workstation Service and Logging On 
You must start the Workstation service before you can log on to the network or use the 
LAN Manager Screen. 

To start the Workstation service, at the MS-DOS prompt, type 

net start workstation 

Once the Workstation service is started, you must log on. The procedure for logging on 
using the LAN Manager Screen is given first, followed by the equivalent command typed 
from the command line. 
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~ To logon: 

1. Start the LAN Manager Screen from the command line by typing 

net 

NOTE Typing net /mono improves the LAN Manager Screen display for some computer screens. 
Try the command with and without /mono to determine which display you prefer. 

The following message box appears: 

,----- Log Onto lietwork ----, 

UsernaMe [~ .............. ] 
Password [.... . .. ] 

DOMain [ ..... . ... ] 

( OK ) (Cancel) 

Your username should appear in the "U sername" text box. If it is not displayed, see 
your administrator. You can specify a different username by typing over the username 
that is displayed. 

2. To move the cursor to the "Password" text box, press TAB, then type your password. 

The password is not displayed as you type it. 

3. To move the cursor to the "Domain" text box, press TAB. Leave this text box blank to 
log on in the workstation domain. 

4. Type a domain name to specify a logon domain. 

5. To move to the <OK> command button, press TAB. Press ENTER. 

Message boxes are displayed telling you that the logon was successful and what 
privilege level you have at your workstation. The privilege level defines the range of 
action you have at your workstation or on a server. To remove message boxes from the 
LAN Manager Screen, press ESC. 

Along with the Workstation service, LAN Manager Enhanced, by default, starts these 
other services: 

• The Messenger service, which lets you send, receive, and log messages to a file . 

• The Netpopup service, which displays messages on your computer's screen when they 
are received from another user or a server on the network. These messages are not part 
of the LAN Manager Screen; they appear regardless of which application you are using. 
The Netpopup service requires that the Messenger service be running. 

These services are described in more detail in Chapter 5, "Sending and Receiving 
Messages." 
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com~~~~ ~ To start the Workstation service and log on: 

1. Start the Workstation service by typing 

net start workstation 

2. Log on to the network by typing 

net logon [username [password I *]] [/domain:name] 

See Net Start Workstation and Net Logon, Chapter 7, "Enhanced Command Reference." 

The LAN Manager Screen 
The LAN Manager Screen lets you browse around the network, locate shared resources, 
and connect to those resources without having to memorize commands or syntax. 

Figure 2.1 shows the LAN Manager Screen, noting the elements of the screen. 

Current focus 
Menu bar Workstation information 

'View Message Config Accounts Help 
~ Current focus : \\1-2128 {vour IlSel'n... . . PETERP 

Your co~puterna~e \\1-2128 
~our do~ain . . . HEADQTRS 

Set current focus on [\\1-2128 ] 

Seruer na~e Re~ark 

,I" I 

• .1lI-_III.,._."! .11ol ........ "'.1W1I : t 

J ADMINSTR Ad~inistration seruer I. FINANCE2 ~~n 

FINANCIAL Finance dept printer seruer iiil 

1 
MIS Printer seruer 

/j 
MRKTING Marketing depart~ent 386 
PRODUCTION Production file seruer 

"- SALES Sales records and lists 

l 
I ! 

/ 

Press the ALT key to select a ~enu ~icrOsoft LAN Manager i 

( Message line 
Servers in the 10 g on and workstation domains Scroll bar 

Figure 2.1 The LAN Manager Screen 
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The fields of the LAN Manager Screen provide the following infonnation: 

Menu bar 
Displays the names of menus from which you can choose commands. 

Current focus 
Shows the computername of your workstation or the server that is the focus of activity 
when using LAN Manager Screen commands. 

Workstation information 
Provides the following infonnation about your workstation: 

Your username 
The username specified when you logged on to the network. 

Your computername 
The computername specified when the workstation was started. 

Your domain 
The name of your logon domain. This is the domain name specified when you 
logged on to the network. If you didn't specify a domain name, you 
automatically logged on in the workstation domain. Note that the workstation 
domain and the logon domain are the same if you are logged on in the 
workstation domain. 

Servers in the logon and workstation domains 
Lists the servers in your logon and workstation domains. 

Scroll bar 
Lets you scroll through the servers in the list box with the mouse. 

Message line 
Provides a brief statement about the menu, command, or current task. 

To use the LAN Manager Screen, you select a menu, which displays a list of commands. 
When you choose a command, a dialog box appears, in which you type information to 
perform a task. 

The following sections explain menus and dialog boxes and tell you how to use the 
keyboard and the mouse to move through them and perfonn tasks. 
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Using Menus and Menu Commands 
Menus are the starting point for any LAN Manager Screen operation. The names of all five 
menus appear in the menu bar across the top of the LAN Manager Screen. When you 
select a menu, a list of commands appears. Except for Exit on the View menu, each 
command leads to a dialog box. If a menu command does not contain a highlighted letter, 
the command is not available. 

From menus on the LAN Manager Screen, you can perform the following tasks: 

View menu 
View and connect to resources shared on servers, view your workstation's 
connections, and view information about users on the network. You can also exit the 
LAN Manager Screen. 

Message menu 
Send, log, and read messages, and specify an alias (a name used to receive messages). 

Config menu 
Log on, log off, use profiles, and view your workstation configuration. 

Accounts menu 
Change the options for your account and change your password at a server. 

Help menu 
Get different types of help with LAN Manager Enhanced. 

When viewing or selecting menus and menu commands, use these keys: 

Key 

ALT 

Highlighted 
letter 

ENTER 

ESC 

Action 

Activates menu names on the menu bar. 

Once menu names are activated with ALT or menu commands are 
displayed, selects the menu or chooses the menu command 
containing the highlighted letter. 

Once a menu is displayed, moves from one menu to another. 

Once a menu is displayed, moves from one command to another. 

Selects the highlighted menu or menu command. 

Removes a menu from the screen. 

To select a menu with the mouse, click the menu name (use the mouse to position the 
pointer on the menu name and press the left mouse button). The menu appears, and you 
can choose a menu command by clicking it. 
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Using Dialog Boxes 
Dialog boxes supply information to perform a task. They contain as many as five types of 
areas, or fields. Each dialog box has a title, which is displayed at the top. 

Dialog Box Fields 
Dialog boxes contain one or more of the following types of fields: 

• Text boxes, which receive typed information 

• List boxes, which present a list of items to select from 

• Check boxes, which let you mark or unmark an option 

• Option buttons, which let you select one of several options 

• Command buttons, which perform an action 

Figure 2.2 shows a dialog box with four types of fields. 

Option buttons Text box r Dia/og box title 

.---------__t_ Load Conf iguration ----------, 

Fi lenallle . . 
Load options 

.. " ............................... ] 
(.) Append to existing configuration 

1-+-------( ) Replace existing configuration 

Display files on (.) Local cOlllputer 
( ) Relllote server \\RESEARCH 

Contents of C:\LANMAN.DOS\PROFILES 

. <current directory} t 
<parent directory> I 

NETLOGON.PRO 
STANDARD.PRO 
TEST1.PRO 

< Dir } 

List box 

Figure 2.2 Dialog box fields 

Illl 
l 

< OK } <Cancel} 

Command buttons 
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Use the following keys to move around in dialog boxes: 

Key 

Highlighted 
letter 

TAB 

SHIFT+TAB 

ENTER 

ESC 

Action 

Moves the cursor to the field containing the highlighted letter. If the 
cursor is in a list box or a text box, hold down ALT while pressing 
the highlighted letter. If moving to a command button, pressing the 
highlighted letter activates the command button. 

Moves the cursor to the next field. 

Moves the cursor to the previous field. 

Carries out the actions you specified. 

Cancels any actions and closes the dialog box. 

The following sections describe each type of dialog box field. 

Text Boxes 
In a text box, you type information. A text box is surrounded by brackets and contains a 
series of dots that are replaced with characters as you type. It sometimes holds more 
characters than appear between the brackets. You can view these characters by using the 
RIGHT direction key to scroll to the left. Sometimes a text box may appear with 
information provided, such as your username. 

When in a text box, use the following keys: 

Key 

HOME 

END 

DEL 

BACKSPACE 

Action 

Moves the cursor one space to the left. 

Moves the cursor one space to the right. 

Moves the cursor to the first character in the text box. 

Moves the cursor to the last character in the text box. 

Deletes the character that the cursor is on. 

Deletes the character to the left of the cursor. 

If you are using the mouse, you can scroll the characters in the text box by clicking the left 
or right bracket. 

List Boxes 
A list box lets you view items by scrolling through a list, or select an item from the list. 
For example, you can view lists of resources available on a server or lists of print jobs 
waiting to be printed. 
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Use the following keys to move around in a list box: 

Key 

PG UP 

PGDN 

HOME 

END 

F5 

Action 

Moves the cursor up one line. 

Moves the cursor down one line. 

Moves the cursor up one page. (A page is the portion of the list that 
appears on the screen.) 

Moves the cursor down one page. 

Moves the cursor to the top of the list. 

Moves the cursor to the bottom of the list. 

Updates a list. 

Pressing a letter while the cursor is in a list box (including the list box of server names on 
the LAN Manager Screen) moves the cursor to the next item that begins with that letter. 

A scroll bar and a scroll box are displayed at the right of the list box. The scroll bar lets 
you use the mouse to move through a list with more than one screen of information. Click 
the up or down arrow to move the view up or down one line. 

The position of the scroll box reflects the position of the information in the window 
relative to the total contents of the list. You can move through the list with the mouse by 
dragging the scroll box (positioning the pointer on the scroll box, holding the left mouse 
button down, then moving the mouse up or down). 

To select an item in a list box with the mouse, click the item. If the dialog box has a 
<Zoom> command button, double-clicking an item (positioning the pointer on the item 
and quickly pressing and releasing the mouse button twice) zooms in on it. Otherwise, 
double-clicking performs the action corresponding to the first command button listed. 

If a dialog box has a pair of list boxes, double-clicking an item in one list box often moves 
it to the other list box. 

Check Boxes 
With a check box, you tum an option on or off. When a check box is marked with an X, 
the option is on. Use the SPACEBAR as a toggle switch to mark or unmark a check box. 

To mark or unmark a check box with the mouse, click it. 

Option Buttons 
With an option button, you select one option from a group of options. One option button is 
always selected, and only one option button can be selected at a time. 
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To select an option button, use the following keys: 

Key Action 

t Changes the selection to the previous option. 

j" Changes the selection to the next option. 

To select an option button with the mouse, click it. 

Command Buttons 
A command button performs a specific action. If a command button does not contain a 
highlighted letter, the command button is unavailable. 

To choose a command button, press TAB to move to the button and press ENTER. You can 
also press the highlighted letter in the command button (if the cursor is in a list box or text 
field, you must hold down ALT while pressing the highlighted letter). 

To choose a command button with the mouse, click it. 

Getting Online Help 
Online help is available for the LAN Manager Screen and for LAN Manager Enhanced 
commands typed at the MS-DOS prompt. 

Getting Help with the LAN Manager Screen 
There are two ways to get help while using the LAN Manager Screen: by selecting the 
Help menu or by pressing FI. The Help menu provides access to help topics. 

To get information about a menu, command, or dialog box, press FI while that item is 
displayed. If you press FI with no dialog box or menu displayed, the following appears: 

~------ HELP - Using the LAN l1anager Screen --------, 
Help: 

M.D!;j;li6l,$il'74i4A44iW ... *.mrm",u.'''4§M'£I4£ 
l1enu bar-~ iew Message Conf ig Accounts 

Action 
area----+--

l1essage 
line---+-Press the ALT key to select a Menu 

( l10re info ... > 

t • Help 

I 
( Previous > (Next > (Back > ( Contents > (Done > 
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To remove a help box from the screen, choose <Done> or press ESC. 

Getting Help from the Command Line 
Several types of help are available from the command line. 

Command ~ To get a list of commands and topics for which help is available, type 
Line 

net help 

To display detailed information about a command, type 

net help command 

To display a command's options, type 

net help command /options 

To display a command's syntax, type 

net command!? 

See Net Help, Chapter 7, "Enhanced Command Reference." 

Getting Help with Error Messages 
To get help with an error that occurs while you are using the LAN Manager Screen, press 
Fl while the message box is displayed. 

Command ~ To get help with an error message, type 
Line 

net helpmsg message# 

See Net Helpmsg, Chapter 7, "Enhanced Command Reference." 

Viewing Network Resources 
With the View menu, you can view servers and shared resources on the network, and view 
users on a server or in a domain. 

After you log on, a list of visible servers in your workstation domain (and your logon 
domain, if a domain other than the workstation domain was specified at logon) is 
displayed on the LAN Manager Screen. You may not have access to all servers listed, and 
all servers you have access to may not be visible. Your administrator determines whether a 
server is visible on the network. Check with your administrator to find out which servers 
are available to you. 
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Setting the Current Focus 
When you start the LAN Manager Screen, the "Current focus" line and the "Set current 
focus on" text box display your workstation's computername. This means the workstation 
is the focus of activity when you use menus and dialog boxes. 

U sing the LAN Manager Screen, you can connect to shared resources and perform other 
tasks at servers. The first step in performing a task is to set the current focus on the server 
that is showing the resources you want to view or use. This makes the server the focus of 
activity. 

~ To set the current focus on a server: 

1. Select the computername of a server by scrolling through the list box or pressing the 
first letter of the server's computername until the name appears in the "Set current focus 
on" text box. Or you can type the server's computername in the "Set current focus on" 
text box. 

2. Press ENTER, or double-click the server name. 

The server's computername is then displayed on the "Current focus" line, and a 
message box is displayed that shows your privileges on that server. 

Viewing Shared Resources 
After setting the current focus on a server, you can view that server's shared resources. 
Shared resources are directories and printers. 

~ To view shared resources on a server: 

1. Set the current focus on the server that you want to view. 

2. From the View menu, choose Available resources. 

The following dialog box appears: 

.-------- Resources Avai lable at "PRODUCTION --------, 
Production file server 

Sharenall\e Type Used as 

EXEC Disk Lill\ited 
LASER 
LPTlQ 
NETLOGON 
PUBLIC 
RECORDS 

Printer 
Printer 
Disk 
Disk 
Disk 

Laser printer in 1-5858 
Backup printer 
Logon share 
Public directory 
Record f i I es 

< Use resource > < ZOOIl\ > < Stop using > 

t 

< View queue contents > < View perll\issions > < Done > 
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The dialog box shows the different types of resources available on that server. Available 
resources include shared directories (Disk) and printers (Printer). 

3. Choose <Done>. 

For more information about connecting to and using shared resources, see Chapter 3, 
"Using Shared Directories," and Chapter 4, "Using Shared Printers." 

Command ~ To view shared resources on a server, type 
Line 

Network Paths 

net view \\computername 

See Net View, Chapter 7, "Enhanced Command Reference." 

Every shared resource on the network is identified by a network path. This is the 
computemame of the server sharing the resource followed by the resource's 
sharename-the name an administrator assigns to it. The computemame is preceded by 
two backslashes (\\), and the sharename is preceded by one backslash (\). 

For example, \\sALES\REPORTS specifies the network path for the REPORTS shared 
directory on the \\sALES server. 

Network paths are used in dialog boxes and in commands typed at the MS-DOS prompt. 

Viewing Users on the Network 
You can view a list of users whose workstations are connected to a particular server or 
who are logged on in a particular domain. 

~ To view information about users connected to a server: 

1. Set the current focus on the server that you want to view. 

2. From the View menu, choose Users on a server. 

The dialog box shown in Figure 2.3 appears. 
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Current Users on Server \\PRODUCTION 

Username Workstation Duration Full name 

ALEXSM SALES2 00:03:04 Alex Smythe t 
ANNAKN EXECUTIVE 00:30:59 Anna Knight • CAROLRA PRODUCTION 00:08:17 Carol Raymond 
CHRISD MIS 00:31:07 Chris Davis 

.a. 

< Zoom > < Done > 

Figure 2.3 "Current Users on Server\\compulername" dialog box 

For each user with a connection to the server, this dialog box lists the username, the 
computername of the workstation where the user is logged on, the length of time since 
the connection was established, and the user's full name. 

3. To view more information about a user, in the list box, select the username and choose 
<Zoom>. 

The dialog box shown in Figure 2.4 appears. 

,-------- InforMation on user CAROLRA ---------, 

Full naMe Carol RaYMond 

COMMent . Production Manager 
User COMMent: Bu i I ding two J 11'14 

< Done > 

Figure 2.4 "Information on user username" dialog box 

4. Choose <Done>. 

5. Choose <Done>. 

comm~~: ~ To view information about users connected to a server, type 

net who \\computername 

See Net Who, Chapter 7, "Enhanced Command Reference." 
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~ To view users logged on in a domain: 

1. From the View menu, choose Users on a domain. 

The following dialog box appears: 

,-------- Select a DOl11ain to View ---, 

Known dOl11ains 

CENTRAL 

< OK ) <Cancel) 

2. In the "Known domains" list box, select a domain and choose <OK>. 

A dialog box appears that lists the users logged on in that domain. The fields contain the 
same types of information as those shown in the "Current Users on Server 
\'-L'omputername" dialog box (Figure 2.3). 

3. To view information about a user, in the list box, select the username and choose 
<Zoom>. 

More information about the user appears in the "Information on user username" dialog 
box (Figure 2.4). 

4. Choose <Done>. 

5. Choose <Done>. 

Command ~ To view users logged on in a domain, type 
Line 

net who Idomain:name 

See Net Who, Chapter 7, "Enhanced Command Reference." 

Understanding LAN Manager Accounts 
LAN Manager uses user accounts to control access to domains and shared resources. 
These accounts contain information about users. In a domain, accounts specify which users 
can log on. On a server, accounts specify which users can use shared resources. 

In a domain, your account includes the username and password that you must supply to log 
on, your full name, a comment about you, and a record of the hours during which you can 
log on. When you log on in a domain, the domain controller or a logon server verifies that 
the username and password you supply match those in an existing user account. 
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An account on a server includes your username and the password you must supply to gain 
access to the server's resources. If the password you supplied when you logged on matches 
the password in a server's account, you can use the server's resources. Otherwise, you 
must supply a password when connecting to a resource to gain access. Note that having an 
account on a server does not guarantee access to all of its resources. Your administrator 
can set up permissions for each user to control access to each of the server's resources. 

Viewing Information About User Accounts 
You can view information about your account, such as your username, account privileges, 
date of last logon, and logon times. 

~ To view information about your user account: 

1. To view information about your account in the logon domain, set the current focus on 
your workstation, or to view information about your account at a server, set the current 
focus on that server. 

2. From the Accounts menu, choose Your account. 

The following dialog box appears: 

.--------- View Your Account at "EXECUTIVE ----------, 

Username .... 
Full name . . . 
Privilege level 
Operator privileges 
Last logon . 

PETERP 
Peter Price 
User 
None 
01-15-90 08:33pm 

User comment [New office--1-2128··········· .. ] 

Countr!:;l code [0······] (S!:;Istem default) 

Password last changed: 01-10-90 08:33pm 
Next change available: 01-17-90 08:33pm 
Password expires : 04-10-90 08:33pm 

Home directory . 

< Logon times> < OJ( > <Cance 1> 

If the current focus is set on your workstation, the computemame displayed in the dialog 
box title is that of the primary domain controller. 

Except for the "User comment" and "Country code" fields, the information in this 
dialog box cannot be changed. 

The "User comment" text box lets you enter a comment about yourself that others can 
read, such as your office location or phone extension. This comment is displayed after 
your name in the "Information on user username" dialog box (Figure 2.4) under the 
Users on a server or Users on a domain command in the View menu. It is also 
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displayed when you type net who username from the command line. The "User 
comment" field can have as many as 48 characters. 

The "Country code" number specifies the language in which servers send messages to 
you. For more information about country codes, see Appendix B, "Country Codes." 

3. Choose <Logon times>. 

The following dialog box appears: 

,.---- Hours 'lou May Log Onto Server \\PRODUCTION ----, 

(A.M.) 11 (P.M.) 11 
M 1 2 3 4 5 6 789 0 1 N 1 2 3 4 5 6 7 8 9 0 1 M 

Sunday ~ ~ S 
Monday ~ .. M 

Tuesday ~ • T 
Wednesday ~ .. W 

Thursday ~ ~ T 
Friday ~ .. F 

Saturday ~ ~ S 

< Done > 

This dialog box displays the times during which you can use the server's resources. 
Your administrator determines these times. You cannot edit any of the fields. 

4. Choose <Done>. 

5. Choose <OK>. 

Changing Your Password 
You may need to change your password for an account if, for example, it is nearing 
expiration. LAN Manager alerts you when your password is expired. 

See your administrator if you forget a password. 

~ To change your password: 

1. To change your password in your logon domain account, set the current focus on your 
workstation, or to change your password on a server, set the current focus on that server. 

2. From the Accounts menu, choose Change your password. 



The following dialog box appears: 

,---- Change Password at "PRODUCTIOH ----, 

Usernallle .. 

Old password 
Hew password 

[~------------------] 

[ - - - - - - - - - - - - - - - - - - - - - - - - ] 

[ - - - - - - - - - - - - - - - - - - - - - - - - ] 

( OK > (Cancel> 
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3. In the "Old password" text box, type your current password. 

4. In the "New password" text box, type your new password. 

5. Choose <OK>. 

Command ~ To change your password, type 
Line 

net password [f\\computername I Idomain:name] username oldpassword newpasswordJ 

See Net Password, Chapter 7, "Enhanced Command Reference." 

Exiting the LAN Manager Screen 
Exiting the LAN Manager Screen returns you to the MS-DOS prompt but does not log you 
off from the network or stop LAN Manager Enhanced services. You can still use the 
connections you made from the LAN Manager Screen. 

~ To exit the LAN Manager Screen: 

1. Press ESC to close each open dialog box. 

2. Press F3, or from the View menu, choose Exit. 

The LAN Manager Screen disappears, and the MS-DOS prompt appears on your 
computer's screen. 

To restart the LAN Manager Screen, type net at the MS-DOS prompt. 
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Quitting LAN Manager Enhanced 
Quitting LAN Manager Enhanced involves two steps: 

• Logging off from the network 

• Stopping the Workstation service 

Logging Off from the Network 
Logging off removes your username and password from the workstation and cancels any 
existing connections to shared resources, but it does not stop LAN Manager Enhanced 
services. Log off when you won't be using the workstation for a while. That way, no one 
can use your network identity to use resources to which you have access. 

~ To log off from the network: 

1. From the Config menu, choose Log off from LAN. 

If you have any connections, the following message box appears: 

You have network connections; logging your current usernal'l'le off 
the network will break these connect ions. Do you wish to proceed 
to log off usernal'l'le PETERP? 

< OK ) <Cancel) 

2. To continue logging off, choose <OK>. 

The following message box appears: 

Successfully logged off your usernal'l'le frol'l'l the network. 

< OK ) 

3. Choose <OK>. 

Once logged off, you can't use any shared resources. However, the Workstation service is 
still running. 



commL~:: ~ To log off from the network, type 

net logoff 
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See Net Logoff, Chapter 7, "Enhanced Command Reference." 

Stopping the Workstation Service 
When you stop the Workstation service, all network services are stopped and connections 
to the network are ended. You must restart the Workstation service and log on if you want 
to use the network again. 

Alternatively, the workstation can be paused, which is similar to stopping the workstation 
but doesn't cancel connections. Pausing puts the workstation on hold but keeps your 
username and password active. It also pauses any other services, such as Messenger or 
Netpopup, that are running. See Chapter 6, "Customizing Your Workstation," for more 
information about pausing services. 

Stopping the Workstation service stops all other services and removes software from your 
computer's memory. LAN Manager Enhanced is a "Terminate and Stay Resident" 
program, which means that when it stops, some of the software stays in your computer's 
memory. If other TSR programs are loaded into your computer's memory, the net stop 
command may not work. 

commL~~: ~ To stop the Workstation service, type 

net stop workstation 

See Net Stop, Chapter 7, "Enhanced Command Reference." 

Starting LAN Manager Enhanced Automatically 
LAN Manager Enhanced commands that can be typed at the MS-DOS prompt can be put 
in batch files so that they run automatically. 

For example, to start the Workstation service when you start your computer, put the 
following command in the AUTOEXEC.BAT file: 

net start workstation 

NOTE To maintain network security, do not put your passwords in a batch program. 

To learn more about batch programs, see your MS-DOS manual(s). 

For more information about LAN Manager Enhanced commands, see Chapter 7, 
"Enhanced Command Reference." 
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The LANMAN.INI File 
As you work with LAN Manager Enhanced, you'll see that many aspects of your 
workstation's performance are predefined. For example, when you start the LAN Manager 
Screen, your username probably appears in the "Log Onto Network" dialog box. Likewise, 
your workstation is set up to include a computername, workstation domain, and so on. 

These features or settings are defined in a file called LANMAN.lNI, which resides in the 
LANMAN.DOS directory. LANMAN.lNI is an initialization file that contains an entry 
with a default value for each setting (such as the computername). You can change settings 
temporarily by using the net start command. To change them permanently, edit the 
LANMAN .INI file. 

You normally won't need to adjust LANMAN.INI entries. For information about adjusting 
entries, see your administrator. 

The LANMAN.INI file is discussed in Chapter 6, "Customizing Your Workstation." 
Settings and values are defined in the Microsoft LAN Manager Administrator's Reference. 
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Using Shared Directories 

A shared directory is a disk directory on a server to which users of the network have 
access. A shared directory contains files that are available to network users. Using a shared 
directory, one person can write a report, another person can review it, and a third person 
can format and print it, all without passing a floppy disk around the office. 

This chapter explains how to use shared directories. It includes procedures for viewing, 
connecting to, and disconnecting from a shared directory, and seeing which shared 
directories your workstation is connected to. In addition, the command-line syntax for 
moving and copying files over the network is provided. 

Viewing Shared Directories 
To see which shared resources are available to you, the Workstation service must be 
running and you must be logged on to the network. For information about starting the 
Workstation service and logging on, see Chapter 2, "Getting Started." 

The LAN Manager Screen displays a list of visible servers. This includes servers in the 
workstation domain, logon domain, and other domains (if any) specified in the 
LANMAN .INI file. 

~ To view shared directories: 

1. Set the current focus on the server whose shared directories you want to view. 

2. From the View menu, choose Available resources. 

The dialog box shown in Figure 3.1 appears. 

39 
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..------- Resources Available at "PRODUCTION -------, 
Production file server 

Sharenallle 

LASER 
LPTlQ 
NETLOGON 
PUBLIC 
RECORDS 

T~pe 

Printer 
Printer 
Disk 
Disk 
Disk 

Used as Relllark 

Laser printer in 1-5858 
Backup printer 
Logon share 
Public director~ 
Record f i I es 

< Use resource > < ZOOIll > < Stop using > 
< View queue contents > < View perlllissions > < Done > 

Figure 3.1 "Resources Available at\\computername" dialog box 

Shared directories are listed as "Disk" in the "Type" column. 

3. Choose <Done>. 

Command ~ To view shared directories, type 
Line 

net view \"-L'omputername 

See Net View, Chapter 7, "Enhanced Command Reference." 

Connecting to a Shared Directory 
Connecting to a shared directory allows you to use the directory as if it were another disk 
drive on your workstation. When you connect to a shared directory, you can use files or 
programs in that directory. You can also copy a file or a program to the directory for use 
by others. You usually assign a devicename to the directory. A devicename is a name by 
which your computer identifies a device. A disk drive devicename is a letter followed by a 
colon. 

NOTE If you assign a devicename of a disk drive on your computer (for example, A:), your 
workstation recognizes the network connection-not the local drive-unless the network connection is 
paused or disconnected. Avoid assigning the C: devicename. 

~ To connect your workstation to a shared directory: 

1. Set the current focus on the server with the shared directory you want to use. 

2. From the View menu, choose Available resources. 

The "Resources Available at\"-L'omputername" dialog box (Figure 3.1) appears. The list 
box displays available resources on the server. Directories are listed as "Disk" in the 
"Type" column. 

3. In the list box, select the directory to which you want to connect. 
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4. Choose <Use resource>. 

The following dialog box appears: 

- Use the resource "PRODUCTIOtt'RECORDS -
Record files for production dept. 

Local device [~ ... J 
Password . . [ ................. J 

< OK ) <Cancel) 

LAN Manager Enhanced provides the next available devicename in the "Local device" 
text box, but you can type a different one. 

5. In the "Password" text box, type a password if needed. 

6. Choose <OK>. 

7. Choose <Done>. 

The workstation is now connected to the directory you selected. You can use it the same 
way you use your workstation's disk drives, as shown in Figure 3.2. 

Server 

r.. ~~I ~ Shared as I I PRODUCTIONI RECORDS 

Workstation 1 
NET USE H: I I PRODUCTIONI RECORDS 

Figure 3.2 Making a connection 

Connecting to a Shared Directory Without Setting the Focus 
The LAN Manager Screen allows you to connect your workstation to shared directories on 
servers other than the server of current focus. This includes servers that are not visible on 
the LAN Manager Screen and servers in other domains. 

LAN Manager Enhanced also lets you connect your workstation to servers on the network 
that are not running LAN Manager (for example, XENIX servers). Because these servers 
have different interfaces, their computernames do not appear on the LAN Manager Screen. 
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~ To connect to a directory on a server other than the server of current focus: 

1. From the View menu, choose Used resources. 

The dialog box shown in Figure 3.3 appears. 

Resources in Use by PETERP at \\2099 

[ ] Show deuiceless uses 

Deuice Making use of ReMark 

;., t 
F: \\EXECUTIVE\RECORD2 Records for Project 2 , 
LPT1 \\EXECUTIVE\LASER PriMary laser prin ... 

f 
< Add use > < ZOOM > < stop using > 
< View queue contents > < View perMissions > < Done > 

Figure 3.3 "Resources in Use by username at \\computername" dialog box 

2. Choose <Add use>. 

The following dialog box appears: 

,.------- Use a Network Resource ---------, 
...---------- Type of Use --------, 

I (.) 1 Disk ( ) 3 Deuiceless use I 
( ) 2 Printer 

Local deuice . . [@II ... ] 
Network resource [ .......... . .... ] 

Password .... [. . . ] 

< O~ > <Cancel> 

LAN Manager Enhanced has preselected "Disk" in the "Type of Use" box. 

LAN Manager Enhanced provides the next available devicename in the "Local device" 
text box, but you can type a different one. 

3. In the "Network resource" text box, type the network path of the shared directory. 

4. In the "Password" text box, type a password if needed. 

5. Choose <OK>. 

6. Choose <Done>. 
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Command ~ To connect to a directory on a server other than the server of current focus, type 
Line 

net use devicename \\computername\Sharename [password] 

See Net Use, Chapter 7, "Enhanced Command Reference." 

Making a Onetime Connection to a Shared Directory 
You can use a shared directory without assigning a devicename to the connection. Do this 
from the command line by using the network path as part of a pathname with some 
commands or application programs. 

For example, to use Microsoft Word to edit the LIST.DOC file in the shared directory with 
the network path \\sALES\FARWEST, start Word and load the file by typing 

word \\sales\farwest\list.doc 

The Word program loads the shared file even though you haven't made a previous 
connection to \\sALES\FARWEST. Note that this procedure will not work if a password is 
needed to gain access to \\sALES\FARWEST. If so, you must first establish access to the 
directory. 

Viewing Your Connections 
At any time, you can view directories connected to your workstation. 

~ To view directories connected to your workstation: 

1. From the View menu, choose Used resources. 

The "Resources in Use by username at \'v.'omputername" dialog box (Figure 3.3) 
appears. Devicenames D: through Z: in the "Device" column identify connections to 
shared directories. 

2. Choose <Done>. 

Command ~ To view directories connected to your workstation, type 
Line 

net use 

See Net Use, Chapter 7, "Enhanced Command Reference." 
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Copying Files over the Network 
Use the net copy command to copy a file over the network, to or from your workstation, 
or between servers. The MS-DOS copy command can be used in place of net copy, but 
net copy is faster when both the source and destination are on the same server. Files can 
be copied from the command line only. 

Command ~ To copy a file, type 
Line 

net copy source [destination] 

For example: 

net copy \\production\lists\sales.doc \\production\reports 

See Net Copy, Chapter 7, "Enhanced Command Reference." 

Moving Files over the Network 
Use the net move command to move a file over the network, to or from your workstation, 
or between servers. Files can be moved from the command line only. 

The net move command differs from the net copy command in that it deletes the file at its 
source location when ~t moves the file. 

Command ~ To move a file, type 
Line 

net move source [destination] 

If no destination is specified, the file moves to the current directory. 

See Net Move, Chapter 7, "Enhanced Command Reference." 

Disconnecting from a Shared Directory 
You can disconnect your workstation from a shared directory when you are finished using 
a resource or when you want to use the devicename for a different connection. 

~ To disconnect your workstation from a shared directory: 

1. From the View menu, choose Used resources. 

The "Resources in Use by username at \\computername" dialog box (Figure 3.3) 
appears. 
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2. In the list box, select the shared directory that you want to disconnect your workstation 
from. 

3. Choose <Stop using>. 

4. When prompted for confirmation, choose <OK>. 

5. Choose <Done>. 

Command ~ To disconnect your workstation from a shared directory, type 
Line 

net use devicename Idelete 

See Net Use, Chapter 7, "Enhanced Command Reference." 

Using Home Directories 
Your administrator may have set aside a directory on a server for your own personal use. 
This is your home directory. 

You can use this directory to create and copy files, create and remove subdirectories, and 
do anything else that you ordinarily do with a directory on your own computer. You can 
also set LAN Manager permissions for files and subdirectories, allowing other people to 
use the contents of your home directory. Your administrator can override the permissions 
you set since your home directory is part of the server's disk drive. Your administrator also 
sets a limit on how much disk space you can use for your home directory. 

For information about permissions, see Net Access in Chapter 7, "Enhanced Command 
Reference. " 





Chapter 4 

Using Shared Printers 

With LAN Manager you can print files by sending them from your workstation to shared 
printers. This chapter explains shared printer queues and how to view, connect to, control, 
and disconnect from a printer queue. Procedures are provided for using a printer queue and 
for finding out which printer queues your workstation is using. 

Printer Queues 
A shared printer is one that is available to network users on a server. LAN Manager 
Enhanced uses printer queues to hold print jobs. Jobs sent to a printer queue are printed 
one by one, usually in the order that the queue receives them (see Figure 4.1). 

Workstations 

Server 

Printer Queue Printer 

D 
/11111111 

Figure 4.1 How a printer queue works 

Printer queues can be set up in different ways: one printer can handle jobs from several 
queues, or one queue can send jobs to several similar printers. 

If a single printer receives jobs from several queues, the queues can have different 
priorities for printing. The printer might receive requests from a low-priority queue that 

47 
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accepts jobs from all network users and also from a high-priority queue that accepts jobs 
only from users who need files printed quickly. 

If several printers receive jobs from a single queue, the server controlling the queue 
informs users which printer printed their jobs. 

If the Messenger and Netpopup services are running on your workstation, a message is 
displayed when the print job is printed. For information about the Messenger and 
Netpopup services, see Chapter 5, "Sending and Receiving Messages." 

Viewing Printer Queues and Print Jobs 
You may want to view a list of available printer queues to determine where to send a print 
job or to monitor jobs that you have sent to a particular queue. 

~ To view printer queues and their print jobs: 

1. Set the current focus on the server sharing the printer queue that you want to view. 

2. From the View menu, choose Printer queues. 

The dialog box shown in Figure 4.2 appears. 

,..----------- Print Queues on \\PRODUCTION ----------, 
Job U Size Status 

, 
LPT1Q QUEUE ( 1 Jobs) * Queue Active * 

USER 1 0 Spool ing 
NEWSLETR QUEUE ( 2 Jobs) * Queue Active * 

PETERP 6 1024 Waiting 
PETERP 7 4316 Waiting 

<Hold> <Release> <Restart> <ZOOI1l> <Delete> <Purge> <Done> 

Figure 4.2 "Print Queues on \\compulername" dialog box 

For each queue, the name, number of print jobs waiting, and status of the queue are 
displayed. 

Each print job is identified with a line containing the username, job number (assigned 
by the server), size of the job (in bytes), and status of the job. 

Scroll through the list if necessary. 

3. Choose <Done>. 
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com~~~: ~ To view printer queues and their print jobs, type 

net print \\computername 

See Net Print, Chapter 7, "Enhanced Command Reference." 

Connecting to a Printer Queue 
Connecting to a printer queue allows you to use the queue as if it were a printer attached to 
your computer. You connect your workstation to a printer queue by assigning a 
devicename to the queue. Devicenames LPTl: through LPT3: are available for printer 
queues. 

~ To connect your workstation to a printer queue: 

1. Set the current focus on the server sharing the printer queue that you want to use. 

2. From the View menu, choose Available resources. 

The following dialog box appears: 

.---------- Resources Available at \\PRODUCTIOtt -----------, 
Production file server 

Sharenallle Type Used as Relllark 

LASER 
LPTlQ 
ttETLOGOtt 
PUBLIC 
RECORDS 

Printer 
Printer 
Disk 
Disk 
Disk 

Laser printer in 1-5858 
Backup printer 
Logon share 
Public directory 
Record files 

< Use resource > < ZOOlll > < Stop using > 
< View queue contents > < View perlllissions > < Done > 

The list box displays available resources at that server. Printer queues are listed as 
"Printer" in the "Type" column. 

3. Select the printer queue that you want to use. 

4. Choose <Use resource>. 

The following dialog box appears: 

- Use the resource \\PRODUCTIOtt\LASER ----, 

Local device [lpt1:] 
Password .. [ .... . .... ] 

< OX > <Cancel> 
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LAN Manager Enhanced provides the next available devicename in the "Local device" 
text box, but you can type a different one. 

5. In the "Password" text box, type a password if needed. 

6. Choose <OK>. 

7. Choose <Done>. 

Command ~ To connect your workstation to a printer queue, type 
Line 

net use devicename\"-L'omputername\Sharename [password] 

See Net Use, Chapter 7, "Enhanced Command Reference." 

Connecting to Printer Queues Without Setting the Focus 
The LAN Manager Screen allows you to connect your workstation to printer queues on 
servers other than the server of current focus. This includes servers that are not visible on 
the LAN Manager Screen and servers in other domains. 

LAN Manager Enhanced also lets you connect your workstation to servers on the network 
that are not running LAN Manager. Because these servers have different interfaces, they 
do not appear on the LAN Manager Screen. 

~ To connect to a printer queue on a server other than the server of current focus: 

1. From the View menu, choose Used resources. 

The dialog box shown in Figure 4.3 appears. 

,--------- Resources in Use by PETERP at \\21'199 ---------, 

[ ] Show device less uses 

Device Making use of Remark 

D: \\EXECUTIVE\ACCTLIST Accounting lists 
F: 
LPT1 

\\EXECUTIVE\RECORD2 
\\EXECUTIVE\LASER 

< Add use > < ZOOM > < Stop using > 

Records for Project 2 
Primary laser prin ... 

t • 
t 

< View queue contents> < View perMissions> < Done > 

Figure 4.3 "Resources in Use by lIsername at\\complitername" dialog box 
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2. Choose <Add use">. 

The following dialog box appears: 

,------ Use a Network Resource ----------. 
,-------- Type of Use -----------, 

I (.) 1 Disk ( ) 3 Deviceless use I 
( ) 2 Printer 

Local device .. [~"' ,J 
Network resource [," '." . , " " ...... , . , " ..... " " " " , . , , . " , ] 
Password .... [""".", .. ".""",. "J 

< OU > <Cancel> 

3. In the "Type of Use" list box, select the "Printer" option button. 

LAN Manager Enhanced provides the next available devicename in the "Local device" 
text box, but you can type a different one. 

4. In the "Network resource" text box, type the network path of the printer queue. 

5. In the "Password" text box, type a password if needed. 

6. Choose <OK>. 

7. Choose <Done>. 

Command ~ To connect to a shared printer queue, type 
Line 

net use devicename \\computername\5harename [password] 

See Net Use, Chapter 7, "Enhanced Command Reference." 

Making a Onetime Connection to a Printer Queue 
It is not necessary to assign a devicename to a printer queue if you only need to print one 
file. You can copy the file directly to a printer queue by specifying the network path as the 
destination of the net copy command. 

For example, if your current directory contains the PHONE.LST file and you want to send 
the file to the HOLES printer queue on the \\ADMIN server, type 

net copy phone.1st \\admin\ho1es 

LAN Manager Enhanced connects your workstation to the printer queue and copies the file 
to the queue for printing. After copying, the connection is canceled. Note that this 
procedure will not work if a password is needed to gain access to \\ADMIN\HOLES. If so, 
you must first make a connection to the queue by assigning it a devicename. 
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Viewing Your Connections 
~ To view your workstation's connections to printer queues: 

1. From the View menu, choose Used resources. 

The "Resources in Use by username at \~'omputername" dialog box (Figure 4.3) 
appears. If you have a connection to a printer queue, you will see an LPT devicename 
under the "Device" column. 

2. Choose <Done>. 

Command ~ To view your workstation's connections to printer queues, type 
Line 

net use 

See Net Use, Chapter 7, "Enhanced Command Reference." 

Printing over the Network 
Once a connection is made, you can use a printer queue as if a printer were attached to 
your computer. You simply direct the print output to the devicename that you assigned to 
the queue. Many application programs send their output to LPTl: by default. 

In addition, you can send a file to be printed with MS-DOS commands by using the 
devicename assigned to the queue in the syntax for the command, for example: 

copy report.doc lpt2: 

or 

print /d:lpt2 report.doc 

For more information about using the MS-DOS copy and print commands, see your 
MS-DOS manual(s). 

Holding, Releasing, and Deleting a Print Job 
Holding a print job causes the server to suspend the job until you release it. Deleting a 
print job removes it from the queue. 

Your administrator can also hold, delete, or restart a print job if necessary. This can be 
done if a problem with the printer, such as a paper jam, caused printing to stop. 
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~ To hold a print job: 

1. Set the current focus on the server sharing the queue in which you have a print job. 

2. From the View menu, choose Printer queues. 

The "Print Queues on \\computername" dialog box (Figure 4.2) appears. 

3. In the list box, select the print job that you want to hold. Then choose <Hold>. 

The job remains held until you release it. 

~ To release a print job: 

1. Set the current focus on the server sharing the queue in which you are holding a print 
job. 

2. From the View menu, choose Printer queues. 

The "Print Queues on \\computername" dialog box (Figure 4.2) appears. 

3. In the list box, select the print job you want to release. Then choose <Release>. 

4. Choose <Done>. 

~ To delete a print job: 

1. Set the current focus on the server sharing the queue in which you have a print job. 

2. From the View menu, choose Printer queues. 

The "Print Queues on \\£'omputername" dialog box (Figure 4.2) appears. 

3. In the list box, select the print job you want to delete. Then choose <Delete>. 

4. When prompted for confirmation, choose <OK>. 

5. Choose <Done>. 

com~~~: ~ To hold, release, or delete a print job: 

1. Get the job number by typing 

net print {\\£'omputernamef\sharename] I device name} 

2. Take the desired action by typing 

net print {\\£'omputername I devicename} job# {/hold I Irelease I Idelete} 

See Net Print, Chapter 7, "Enhanced Command Reference." 
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Disconnecting from a Shared Printer Queue 
You can disconnect your workstation from a printer queue when you are finished using the 
resource or when you want to use the devicename for a different connection. 

~ To disconnect your workstation from a printer queue: 

1. From the View menu, choose Used resources. 

The "Resources in Use by username at \\computername" dialog box (Figure 4.3) 
appears. 

2. In the list box, select the printer queue that you want to disconnect your workstation 
from. 

3. Choose <Stop using>. 

4. When prompted for confirmation, choose <OK>. 

5. Choose <Done>. 

Command ~ To disconnect your workstation from a printer queue, type 
Line 

net use devicename Idelete 

See Net Use, Chapter 7, "Enhanced Command Reference." 



Chapter 5 

Sending and Receiving Messages 

With LAN Manager Enhanced, you can exchange messages with other network users. In 
addition, servers can send messages that inform you of conditions that require your 
attention or of print jobs that are finished. 

The Messenger service must be started to receive messages from other users and from 
servers on the network. Messages are stored in a message log. 

The Netpopup service displays messages as they are received. It displays a message box 
for one minute on your computer's screen. If the Netpopup service is paused, you can read 
your messages in the message log. If you are not running the Netpopup service or the 
Messenger service, you will not be able to read messages that your workstation receives. 
However, the workstation will emit a beep when a message arrives. 

This chapter discusses how to use the LAN Manager Enhanced message exchange 
features. The procedures for sending a message or file, reading and managing your 
message log, and adding or deleting an alias are provided. 

Sending Messages 
The Messenger service does not need to be running for you to send a message. However, it 
must be running for your workstation to receive messages. 

You can send a message to an alias on the network or to a domain. An alias is a unique 
name to which messages can be sent. A workstation can have three kinds of aliases: 

• A computemame, which is an alias when the workstation is added 

• An alias added with the Message menu's Alias command or the net name command 

• A usemame 

A usemame is not necessarily included as an alias at a workstation. This is because an 
alias must be unique on the network, but a user can be logged on at more than one 
workstation at a time. If a user logs on at several workstations, the usemame will only be 
added as an alias to the first workstation at which the user logs on. 

55 
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A domain name is used like an alias for sending messages. Messages sent to a domain 
name are received by all workstations and servers that specify the domain as the 
workstation domain. 

~ To send a message: 

1. From the Message menu, choose Send a typed message. 

The following dialog box appears: 

r----------- Send a Message -------------, 

To . . ( .) Na",e [ - - - - - - - - - - - - - - - - - - ] 
( ) Do",a in [- - - - - - - - - - - - - - - - - - ] 

Message [- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - ] 

( OK > (Cancel> 

The "Name" option button is selected. 

2. To send a message to a user, in the "Name" text box, specify who is to receive the 
message. 

If you are sending to more than one user, separate the names with a space. If you want a 
copy of the message, you can specify your own alias. 

3. To send a message to all users in a domain, select the "Domain" option button, and type 
the domain name. 

4. In the "Message" text box, type your message. 

Messages sent to all users in a domain cannot exceed 128 characters. 

5. Choose <OK>. 

Command ~ To send a message: 
Line 

• Send a message with one line by typing 

net send alias message 

• Send a message with multiple lines by typing 

net send alias 
message (line 1) 
message (line 2) 
[ ... ] 

When you finish, press ENTER, then F6 (or CTRL+Z), then ENTER again. 



• Send a file as a message by typing 

net send alias <filename 
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NOTE Limit your file to 256 bytes, which is approximately one-quarter of a screen of text. If the file is 
larger, the message may not be received. 

See Net Send, Chapter 7, "Enhanced Command Reference." 

Reading Messages 
There are two ways to read messages: through the Netpopup service or through the 
message log. 

To receive messages, you must have the Messenger service running. If you want to see 
messages as they arrive, the Netpopup service must also be running. These services, by 
default, are started when the Workstation service is started. 

A message log is a file that stores messages when they're received. The default message 
log file resides in the LANMAN.DOS\LOGS directory. 

Using the NetpopupService 
When the Netpopup service is running, each new message is displayed in a message box 
on your screen. 

The Messenger service must be running for the Netpopup service to display messages. 

The following is a typical message box: 

Message from EDWARDS to PETERP on 09-17-89 10:04 am 

Meeting at 1 p.m. in main meeting room. See you there! 

Press ESC to exit 
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To remove the message box from the screen, press ESC. (Otherwise, the message box is 
displayed for one minute, then disappears.) 

NOTE The Netpopup service requires that the Winpopup service be running if you are using 
Microsoft Windows™ with LAN Manager Enhanced. The Winpopup service is installed with the Setup 
program. If you are using Microsoft Windows and the Winpopup service is not installed, see your 
administrator. 

Command ~ To pause or continue the Netpopup service, type 
Line 

net pause netpopup 

net continue netpopup 

See Net Pause and Net Continue, Chapter 7, "Enhanced Command Reference." 

Reading Your Message Log 
A message log is a file that stores the workstation's messages. By default, LAN Manager 
Enhanced uses MESSAGES.LOG in the LANMAN.DOS\LOGS directory for the message 
log. 

If the workstation receives messages for more than one user or alias, all messages are 
stored in the same message log. New messages are appended to the log. 

~ To read your message log: 

1. From the Message menu, choose Read message log file. 

The following dialog box appears: 

.------------ Contents of Current l1essage Log ----------, 
C:\LANI1AN.DOS\LOGS\I1ESSAGES.LOG 

l1essage froM DATABASE to PETERP on Sep 28, 1989, 82:S6:84PI1 
Pete --

Nice job on the presentation yesterday. Keep it up. 

-- tIle Boss 

l1essage froM LOUISES to 2121 on Sep 28, 1989, BS:88:24PI1 
FrOM: SERVER at \\FINANCE1 
To: 

< Clear log > 

You can scroll through the list box to read your messages. 

t 

I 

II 

~ 
< Done > 

2. To delete the contents of the current message log, choose <Clear log> 
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3. When prompted for confirmation, choose <OK>. 

4. Choose <Done>. 

Command ~ To read the message log, you can use a text editor or type 
Line 

type [drive:path] filename I more 

Thefilename is the name of your message log. For more information about the MS-DOS 
type and more commands, see your MS-DOS manual(s). 

Specifying a Different Message Log 
You can change the name of your message log. 

~ To change the name of the message log: 

1. From the Message menu, choose Log messages to file. 

The dialog box shown in Figure 5.1 appears. 

,.-------- Spec ify Message Log File --------, 

Current file: C:\LANMAN.DOS\LOGS\MESSAGES.LOG 
New file . . [. - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - ] 

Contents of C:\LANMAN.DOS\LOGS 

.. 
MESSAGES.LOG 
NOVEMBER.LOG 

91'444,'·,144;;"'''t 
<parent directory) • 

[ ] Pause IIIessage logging 

< Dir ) < OK ) <Cancel) 

Figure 5.1 "Specify Message Log File" dialog box 

2. In the "New file" text box, type the pathname of the new file, or use the "Contents of 
path" list box and the <Dir> command button to select an existing filename. 

If you do not specify a path, the new message log is stored in the 
LANMAN.DOS\LOGS directory. If you type a filename without an extension, LAN 
Manager Enhanced attaches the .LOG extension. 

3. Choose <OK>. 
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Command ~ To change the message log file that stores your messages, type 
Line 

net log [drive:path]filename 

See Net Log, Chapter 7, "Enhanced Command Reference." 

Stopping and Starting Message logging 
You can stop and restart message logging. 

~ To stop or start message logging: 

1. From the Message menu, choose Log messages to file. 

The "Specify Message Log File" dialog box (Figure 5.1) appears. 

2. Mark or unmark "Pause message logging." 

(An X in the check box means message logging is paused.) 

3. Choose <OK>. 

Command ~ To stop or start message logging, type 
Line 

net log loff 

net log Ion 

See Net Log, Chapter 7, "Enhanced Command Reference." 

Printing Messages 
Instead of storing your messages in a message log, you can print messages as soon as they 
arrive. 

~ To print messages as they arrive, type 

net log devicename 

To resume storing messages in a message log, type 

net log [drive:path] filename 

See Net Log, Chapter 7, "Enhanced Command Reference." 



Chapter 5 Sending and Receiving Messages 61 

Using Aliases 
More than one person can receive messages at a workstation. Since only one user can log 
on at a workstation at any given time, you need to add an alias for each person using the 
workstation. However, you can't add an alias that is in use at another workstation. 

Aliases are deleted when the Messenger service is stopped. Therefore, each time that you 
restart the Messenger service, you'll need to add any aliases that you want on the 
workstation. 

Adding an Alias 
An alias can have as many as 15 characters. 

~ To add an alias to the workstation: 

1. From the Message menu, choose Aliases. 

The dialog box shown in Figure 5.2 appears. 

,..--------- Al iases for Messaging -----------, 

Hallie Forwarded to 

< Add alias> < Delete> 

Figure 5.2 "Aliases for Messaging" dialog box 

2. Choose <Add alias>. 

The following dialog box appears: 

,------ Add an Alias --------, 

Hew al ias [ .................... ] 

< OJ( > <Cancel> 

I ~ 
< Done > 
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3. In the "New alias" text box, type the new alias. 

4. Choose <OK>. 

5. Choose <Done>. 

Command ~ To add an alias to the workstation, type 
Line 

net name alias ladd 

See Net Name, Chapter 7, "Enhanced Command Reference." 

Deleting an Alias 
You can delete an alias on your workstation or an alias that is forwarded to your 
workstation. 

~ To delete an alias from the workstation: 

1. From the Message menu, choose Aliases. 

The "Aliases for Messaging" dialog box (Figure 5.2) appears. 

2. In the list box, select the alias that you want to delete. 

3. Choose <Delete>. 

4. Choose <Done>. 

NOTE You cannot delete the workstation's computername from the alias list. 

Command ~ To delete an alias from the workstation, type 
Line 

net name alias Idelete 

See Net Name, Chapter 7, "Enhanced Command Reference." 



Chapter 6 

Customizing Your Workstation 

LAN Manager Enhanced provides several ways to manage workstation resources. This 
chapter describes how to automatically connect the workstation to a set of shared resources 
(using a profile). It also describes how to control and adjust services, and how to view 
your workstation's configuration. 

Using Profiles 
A profile is a file that automatically connects your workstation to a group of shared 
resources. (The group of connections is defined when you save the profile). The 
connections are made when you load the profile. 

When you save a profile, LAN Manager Enhanced records your workstation's current 
network connections under the profile filename that you assign. Later, you can load the 
profile and regain the connections. 

For example, you may have a task that requires you to use a particular group of shared 
resources. You can connect your workstation to the resources and save the connections in 
a profile. Any time you need to perform the task, you can load the profile rather than make 
the connections individually. 

A profile is created using either the Config menu's Save profile command or the net save 
command. A profile is loaded with the Config menu's Load profile command or the 
net load command. Profiles are stored in the LANMAN .DOS\PROFILES directory unless 
you specify otherwise. 

One profile-NETLOGON.PRO-has a special purpose. IfNETLOGON.PRO exists, it is 
loaded by default whenever a user logs on at a workstation. It is useful to save the 
connections you most often make in NETLOGON .PRO. 

NETLOGON .PRO is created if you don't specify a filename with the Config menu's 
Save profile command or the net save command. NETLOGON.PRO is loaded if you 
don't specify a filename with the Config menu's Load profile command or the net load 
command. 
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Creating a Profile 
You can create a profile at any time to save a set of connections. This gives you the 
flexibility of having a set of connections specific to a task. 

~ To save your current connections in a profile: 

1. From the Config menu, choose Save profile. 

The following dialog box appears: 

r----------- Save Conf iguration -----------, 

Fi lenaMe . . 
Save current 

[ tliij!.rijt1;"Q;nl - - : - ..... - ......... - .. - ... - . - - ] 
[Xl Used resources [Xl Print settings 
[Xl Shared resources [Xl COMM settings 

Displa~ files on (0) Local COMputer 
( ) ReMote server "RESEARCH 

Contents of C:'LANtiAN.DOS'PROFILES 

. <current director~> f 
<parent director~> I 

NETLOGON.PRO 
STANDARD.PRO 
TESTt.PRO 

~. 
~-------------.----------~ 

< Dir > < OJ( > <Cance I> 

2. In the "Filename" text box, type the profile name (if you do not type an extension, LAN 
Manager Enhanced adds the .PRO extension). 

You can also use the "Contents of path" list box with the <Dir> command button to 
select a profile. This replaces the contents of the existing profile with the workstation's 
current connections. When prompted for confirmation, choose <OK>. 

3. Choose <OK>. 

Command ~ To save your current connections in a profile, type 
Line 

net save [[drive:path]filename] 

See Net Save, Chapter 7, "Enhanced Command Reference." 
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Loading a Profile 
You can load a profile to automatically connect your workstation to a group of shared 
resources. 

~ To load a profile: 

1. From the Config menu, choose Load profile. 

The following dialog box appears: 

r---------- Load Conf iguration ------------, 

Fi lenalYle . . 
Load options 

[ ;ijj!tIH'J;'Q;o]. - - - - - - - - - . - - - - - - - - - - - - - . - - - - . ] 
(0) Append to existing configuration 
( ) Replace existing configuration 

Display files on (0) Local cOlYlputer 
( ) RelYlote server "RESEARCH 

NETLOGON.PRO 
STANDARD. PRO 
TEST1.PRO 

( Dir > 

;I'444"W;I'44;;·'W"t 
(parent directory>~ 

]1 

( OH > (Cancel> 

2. In the "Filename" text box, type the filename of the profile you want to load, or use the 
"Display files on" option and the "Contents of path" list box. 

If the profile is not in the workstation's LANMAN .DOS\PROFILES directory or in a 
directory on your computer's path, you must specify its full pathname. If you do not 
type a filename extension, LAN Manager Enhanced assumes the .PRO extension. 

3. Select one of the "Load options:" 

• "Append to existing configuration" adds the profile's connections to your 
workstation's current connections 

• "Replace existing configuration" replaces your workstation's connections with the 
profile's connections 

4. Choose <OK>. 

To view the new connections, from the View menu, choose Used resources. 

Command ~ To load a profile and view your new connections: 
Line 

1. Load a profile by typing 

net load [[drive:path]filename] 
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2. View your new connections by typing 

net use 

See Net Load and Net Use, Chapter 7, "Enhanced Command Reference." 

Controlling Services 
LAN Manager Enhanced services are 

• The Workstation service, which lets you use network resources 

• The Messenger service, which lets you receive messages at your workstation 

• The Netpopup service, which displays messages on your screen 

The Workstation service must be running before the Messenger and Netpopup services can 
start. 

Pausing a Service 
Pausing a service puts it on hold. Unlike stopping, pausing does not cancel connections or 
change settings. 

When you pause the Workstation service, you can use your computer's devicenames for 
local resources instead of shared resources. For example, the LPT 1: devicename might be 
assigned to a shared printer queue. By pausing the Workstation service, you can use the 
devicename for a printer attached to the LPT 1 port on your computer. 

Pausing the Workstation service also pauses the Messenger and Netpopup services. 

Command ~ To pause a service, type 
Line 

net pause service 

See Net Pause, Chapter 7, "Enhanced Command Reference." 

Continuing a Service 
When a service is continued, it resumes running as it was before it was paused. 

Command ~ To continue a service, type 
Line 

net continue service 
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See Net Continue, Chapter 7, "Enhanced Command Reference." 

Pausing and Continuing Connections to Resources 
In addition to pausing a service, you can pause your workstation's connections to shared 
directories or shared printer queues. 

When you pause connections, your workstation does not recognize the devicenames 
assigned to the connections. If you've assigned a local devicename to a network 
connection (for example, LPTI :), pausing the connection lets you use the devicename for a 
local resource. 

The drdr option is used with the net pause and net continue commands to pause and 
continue connections to shared directories. The prdr option is used to pause and continue 
connections to shared printer queues. 

com~~~: ~ To pause and continue directory or printer queue connections: 

• Pause directory or printer queue connections by typing 

net pause {drdr I prdr} 

• Continue connections by typing 

net continue {drdrlprdr} 

See Net Pause and Net Continue, Chapter 7, "Enhanced Command Reference" 

Stopping the Workstation Service 
Stopping the Workstation service logs you off from the network. It also stops the 
Messenger and Netpopup services, deletes message aliases, and cancels network 
connections, . 

com~~~: ~ To stop the Workstation service, type 

net stop workstation 

See Net Stop, Chapter 7, "Enhanced Command Reference." 

Adjusting Services 
LAN Manager Enhanced services are controlled by options, which have values that 
determine how the service will perform. When you start a service, you can adjust the 
values of these options for as long as the service is running. When you stop and restart the 
service, LAN Manager Enhanced restores default settings for the options. 
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Default settings are determined by an initialization file called LANMAN.lNI, which is 
stored in the LANMAN. DOS directory. This file lists each option and its default value. 

Always consult your administrator before you adjust the value of an option. 

Service options are listed in each service's net start reference page in Chapter 7, 
"Enhanced Command Reference." 

Command ~ To adjust a service's performance when you start it, type 
Line 

net start service [options] 

See Net Start Messenger, Net Start Netpopup, and Net Start Workstation, Chapter 7, 
"Enhanced Command Reference." 

Viewing the Workstation Configuration 
Your workstation configuration includes information such as your username and the 
domains that you participate in. 

~ To view your workstation's configuration: 

1. From the Config menu, choose Workstation options. 

The following dialog box appears: 

,------ View Conf iguration for Workstation \\1-2128 -----, 

Current llsername 
Primary domain . 
Logon doma in. . 
Other domains . . 

: PETERP 
: HEADQTRS 
: HEADQTRS 
: CENTRAL EAST 

Software version number: 2.88 

Start workstation services: [X] Messenger [X] Netpopllp 

< Done > 

An X in the "Messenger" and "Netpopup" fields means the services are running. These 
fields cannot be changed in this dialog box. 

2. Choose <Done>. 

Command ~ To view your workstation's configuration, type 
Line 

net config workstation 

See Net Config Workstation, Chapter 7, "Enhanced Command Reference." 



Chapter 7 

Enhanced Command Reference 

This chapter provides a reference page for each LAN Manager Enhanced command. The 
purpose and syntax of the command, as well as comments, examples, and cross-references, 
are provided on each reference page. Reference pages are arranged in alphabetical order. 

Abbreviating Commands 
The reference pages spell out all command and service names. If a command has an 
abbreviation, it is listed on the command reference pages. You can abbreviate any 
command option by typing enough letters to distinguish it from the command's other 
options. 

Using Iyes and Ino Options 
Many LAN Manager Enhanced commands require confirmation to complete a task. To 
expedite the task, you can append the Iyes or Ino option to the command. These options 
can be abbreviated Iy and In. 

For example, the net logon command logs you on to the network. If a user is already 
logged on at a workstation, that user must be logged off before you can log on. If you want 
to log on at a workstation at which another user is logged on (your username is chris) and 
your password is daffodil), type 

net logon chrisj daffodil 

LAN Manager Enhanced will return a series of prompts asking you to confirm logging off 
the current user and canceling the workstation's existing connections. You must type Y or 
press ENTER to proceed with the logon. To log on without getting any prompts, use the Iy 
option. Type 

net logon chri sj daffodi 1 /y 
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Using Passwords with Commands 
Some commands require that you supply a password to connect to a shared resource. 
There are two ways to provide one: 

• Type the password with the command. For example, to provide the password petunia 
while assigning LPTl: to the LISTS shared directory on the \\ADMIN server, type 

net use lptl: \\admin\lists petunia 

• Type an asterisk (*) instead of the password. LAN Manager Enhanced prompts you for 
the password. For example, type 

net use lptl: \\admin\lists * 

LAN Manager Enhanced then displays this prompt: 

Type the password for \\ADMIN\LISTS: 

When you type the password at this prompt, the letters are not displayed. This keeps the 
password confidential. 

Controlling a Screen Display 
Some commands (for example, net help start workstation /options) produce more than 
one screenful of text. 

To stop the display from scrolling, press PAUSE or CTRL+S. To resume scrolling, press any 
key. 

You can also use the MS-DOS more command to scroll through one screenful at a time, 
for example: 

net help start workstation I more 

This displays one screenful of text. To display another screenful, press any key. 

Using Commands in Batch Files 
LAN Manager Enhanced commands can be used in batch programs (.BAT files), such as 
AUTOEXEC.BAT. For example, you can use commands to start the Workstation service, 
log on at the network, or make network connections. Command options can also be 
included in batch programs. To avoid confusion, do not abbreviate command options. 
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Command Summary 
The following list tells what each LAN Manager Enhanced command does. 

net 
Starts the LAN Manager Screen. 

net access 
Displays or changes a user's permissions for a shared directory or file on a server. 

net config workstation 
Displays the current settings for the Workstation service. 

net continue 
Reactivates services or network connections suspended with the net pause command. 

net copy 
Copies files from a source to a destination. 

net help 
Displays a list of commands and topics for which you can get help, or provides help 
with a specific command or topic. 

net helpmsg 
Provides help with a LAN Manager Enhanced error message. 

net load 
Loads a profile. 

net log 
Controls or displays information about message logging. 

net logoff 
Logs a user off from the network. 

net logon 
Logs a user on to the network and sets the username, password, and domain at a 
workstation. 

net move 
Moves files from a source to a destination. 

net name 
Adds or deletes a message alias, or displays a workstation's list of aliases. 

net password 
Changes the password for a user account on a server or in a domain. 
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net pause 
Pauses a service or network connections. 

net print 
Displays information about a shared printer queue or controls a user's print jobs. 

net save 
Creates a profile containing the workstation's connections to shared resources. 

net send 
Sends a message or short file to one or more users on the network. 

net start 
Starts a LAN Manager Enhanced service or displays services that are running. 
(Individual reference pages are provided for net start messenger, 
net start netpopup, and net start workstation.) 

net stop 
Stops the Workstation service. 

net time 
Synchronizes the workstation's clock with a server, or displays the time and date for a 
server or domain. 

net use 
Connects a workstation to or disconnects a workstation from a shared resource, or 
displays information about workstation connections. 

net view 
Displays a list of servers or displays resources that a server is sharing. 

net who 
Lists users logged on in a domain, at a server, or at a workstation. It also lists 
information about a user. 



Net 

Net 
Purpose 

Syntax 

Comments 

See Also 

The net command starts the LAN Manager Screen. 

net [/mono] 

where 

Imono 
Improves the LAN Manager Screen on a computer with a monochrome screen 
display. Use this option if you have difficulty viewing the LAN Manager Screen on 
your computer. 

After you type net, the LAN Manager Screen appears: 

View Message Config Accounts Help 
Current focus : \\1-2128 Your usernaMe .. PETERP 

Your cOMputernaMe \\1-2128 
Your dOMain \\PRODUCTION 

Set current focus on [\\1-2128 

Server naMe ReMark 

*Local* (Your local workstation \\1-2128) 
ADMINSTR 
FINANCE2 
FINANCIAL 
MIS 
MR](TING 
PRODUCTION 
SALES 

AdMinistration server 

Finance dept printer server 
Printer server 
Marketing departMent 38f. 
Production file server 
Sales records and lists 

t • 

I 
Press the ALT ke~ to select a Menu Microsoft LAN Manager 

From this screen, you can use menus and dialog boxes to perform network tasks rather 
than typing LAN Manager Enhanced commands at the MS-DOS prompt. 

For information about See 

The LAN Manager Screen Chapter 2, "Getting Started" 
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Net Access 
Purpose 

Syntax 

Net Access 

The net access command displays or changes a user's permissions for a shared directory 
or file on a server. 

net access drive:pathname [ladd name:permission[ ... ]] 

net access drive:pathname [lcbange name:permission[ ... ]] 

net access drive:pathname [lgrant name:permission[ ... ]] 

net access drive:pathname [lrevoke name:permission[ ... ]] 

where 

drive 
Is the devicename assigned to the shared directory containing the resource with 
permissions you want to change. This devicename must be assigned to a shared 
directory. 

pathname 
Is the resource with permissions you want to change. 

name 
Is one or more usernames or groupnames that are to gain or lose permissions. 

permission 
Is one to seven letters (RWCXDAP) specifying the types of permissions to be given to 
name for the resource. 

ladd 
Creates a new set of permissions for a resource that has none assigned. You can type 
several name:permission strings separated by spaces. You must create a set of 
permissions for the resource before you can grant or revoke permissions. To keep 
control over the resource, give yourself P permission. 

Icbange 
Changes one or more users' permissions for a resource. You can type several 
name:permission strings separated by spaces. 

Igrant 
Assigns additional permissions to a resource's existing set. You can type several 
name:permission strings separated by spaces. 

Irevoke 
Cancels one or more users' permissions for a resource. You can type several 
name:permission strings separated by spaces. 
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Comments 
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Your administrator may have assigned you a home directory, which is a directory for your 
own personal use, on a server. After you connect to the server, this directory and the files 
on it can be controlled so that only certain users can have access to them. Permissions 
control a user's access to a file or directory. 

Permissions and what they allow the user to do are as follows: 

R (Read) 
Read and copy files, and view subdirectories. 

W (Write) 
Make changes to files. 

C (Create) 
Create files and subdirectories. 

X (Execute) 
Run a command or program. 

D (Delete) 
Remove files and subdirectories. 

A (Attributes) 
Change MS-DOS file attributes. For information about file attributes, see your 
MS-DOS manual(s). 

P (Permissions) 
Assign or alter permissions for a resource. Your administrator initially must give you 
this permission for a resource. Once you have it, you can use net access to assign 
permissions, including P, to other users or groups. If you create a new file or 
directory, be sure to assign yourself P permission. Otherwise, you will be denied 
further access to the resource. 

You must specify the devicename assigned to the shared directory and the pathname of the 
resource. When you specify a drive (or pathname) with net access, you get information 
about a resource's current set of permissions. The display looks similar to the following: 

Resource Permissions 

D:\MASTERDIR 
BILLRA:RWCXDAP 

*CORPOP:RWCDA 

Permissions 

*USERS:RWCDA 

This display lists the resource you specified and a two-column list of usemames and 
groupnames who can use the resource. Groupnames are designated by an asterisk (*). 
Following each usemame and groupname is a list of permissions assigned to it. 

You must have P permission for the resource to get information about it with net access. 
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See Also 

Net Access 

If you create a new file or directory and want to assign pennissions to it, first use the ladd 
option to specify which users and groups will have access. Be sure to add yourself (with P 
pennission), or you'll be denied subsequent access. 

Use the Igrant and Irevoke options to add and cancel pennissions for users and groups. 
Use the Ichange option to change existing pennissions for a resource. 

If you create a file in a directory with pennissions, the new file inherits the directory's 
pennissions. Only if you want to change the file's pennissions should you use the 
net access command. 

A. To view the pennissions for the shared directory connected to the G: devicename, type 

net access g: 

B. To add the user jamesro with read and write pennissions to the users on the shared 
directory connected to the G: devicename, type 

net access g: /grant jamesro:rw 

For information about 

Connecting to shared resources 

Shared resources, permissions, and 
user accounts 

See 

Net Use 

Microsoft LAN Manager Administrator's 
Guide 



Net Config Workstation 

Net Config Workstation 
Purpose 

Syntax 

Comments 

Example 

See Also 

The net config workstation command displays the current settings for the Workstation 
service. 

net config workstation 

The net config workstation command provides a way to check settings for the 
workstation, such as the logon domain and the username. 

To display the current settings for the workstation service, type 

net config workstation 

For information about 

Controlling and adjusting services 

Changing settings when starting the 
Workstation service 

See 

Chapter 6, "Customizing Your Workstation" 

Net Start Workstation 
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Net Continue 
Purpose 

Syntax 

Comments 

See Also 

Net Continue 

The net continue command reactivates services or network connections suspended with 
the net pause command. 

net continue {workstation I messenger I netpopup I drdr I prdr} 

where 

workstation 
Continues all workstation connections, and the Messenger and Netpopup services. 

messenger 
Continues the Messenger service. 

netpopup 
Continues the Netpopup service. 

drdr 
Continues all workstation connections to shared directories. 

prdr 
Continues all workstation connections to shared printer queues. 

The net continue command can be abbreviated as net cont. 

For information about 

Pausing and continuing a service or 
connections using the LAN 
Manager Screen 

Pausing a service or network 
connections 

See 

Chapter 6, "Customizing Your Workstation" 

Net Pause 
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Net Copy 
Purpose 

Syntax 

Comments 
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The net copy command copies files from a source to a destination. 

net copy source[ +source[ + ... ]] [/a I /b] [destination [/a I /b] [Iv]] 

where 

source 
Specifies one or more files, directories, or devicenames to be copied. You can specify 
multiple files by separating filenames with a plus sign (+) or by using MS-DOS 
wildcard characters. 

destination 

/a 

/b 

/v 

Specifies which file, directory, or devicename source will be copied to. You can use 
MS-DOS wildcard characters to specify multiple files. 

Treats the source or destination as ASCII text. 

Treats the source or destination as a binary file. 

Verifies that information was properly recorded on the destination disk. 

The net copy command is similar to the MS-DOS copy command, but it is much faster for 
copying between directories on a server. You don't need to connect to shared directories to 
use the net copy command. LAN Manager Enhanced makes the connections for you 
during the copy. 

The net copy command is usually used to copy files, but source can also be a directory (to 
copy all files in the directory), a devicename (such as A: to copy all files in the current 
directory of drive A), or the MS-DOS con command (to copy what is typed at the 
keyboard). Also, destination can be a devicename (such as LPTl: to copy to the device 
connected to LPTl) or it can be a network path. 

If source is a filename, the file is assumed to be in the current directory on the current 
drive. 

If destination is an existing file, the file is overwritten. If destination is a file that does not 
already exist, a new file is created. The new file is given the same name, creation date, and 
creation time as the source file. 

If only a drive is specified as the destination, LAN Manager Enhanced copies to the 
current directory on that drive. If no drive is specified, the source is copied to the current 
drive. 
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Example 

See Also 

Net Copy 

Using the /a or /b Option 

The /a and /b options perform differently depending on whether they follow source or 
destination. The /a option is in effect in both cases until the /b option is specified. 

The /a option causes the file to be treated as ASCII text: 

• Placed after the source, /a causes the copying to stop before the first end-of-file 
character 

• Placed after the destination, /a causes an end-of-file character to be added as the last 
character of the new file 

The /b option copies the file in binary format: 

• Placed after the source, /b copies all end-of-file characters 

• Placed after the destination, /b copies all but the last end-of-file character 

Using the Iv Option 

The /v option verifies that each sector written on the destination disk is recorded properly. 
This slows down the net copy command. 

To copy the MAIL.DOC file from the LISTS directory on the \\sALES server to the 
ADDRESS directory of the \\sALES server, type 

net copy \\sales\lists\mail.doc \\sales\address 

For information about 

Moving files 

MS-DOS copy command 

See 

Net Move 

Microsoft MS-DOS User's Guide and User's 
Reference 
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Net Help 
Purpose 

Syntax 

Examples 
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The net help command displays a list of commands and topics for which you can get help, 
or provides help with a specific command or topic. 

net help [command [/options] I topic] 

net command {/help II?} 

where 

command 
Is the command you need help with (don't type net as part of command). 

topic 
Is the topic you need help with. 

loptions 
Describes the available options of the command. 

Ihelp 
Provides an alternative way to display the help text for a command. 

I? 
Displays the syntax for the command. 

To view a list of commands and topics for which help is available, type net help without 
options. 

A. To view a list of commands and topics for which help is available, type 

net help 

B. To view information about the net load command, type 

net help load 

or 

net load /help 

c. To view the syntax for the net load command, type 

net load /? 

D. To view the options available for the net continue command, type 

net help continue /options 
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See Also For information about 

Getting help while using the LAN 
Manager Screen 

Net Help 

See 

Chapter 2, "Getting Started" 



Net Helpmsg 

Net Helpmsg 
Purpose 

Syntax 

Comments 

Example 

See Also 
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The net helpmsg command provides help with a LAN Manager Enhanced error message. 

net helpmsg message# 

where 

message# 
Is the four-digit number of the LAN Manager Enhanced message that you need help 
with. 

When a network operation fails, you will see a message similar to the following: 

NET2182: The requested service has already been started. 

LAN Manager Enhanced error messages are preceded by "net," but you don't need to type 
net with message#. 

The net helpmsg command provides an explanation of why an error occurred and tells 
you what action to take to solve the problem. 

To get help with LAN Manager Enhanced error message NET2182, type 

net helpmsg 2182 

For information about 

Getting help while using the LAN 
Manager Screen 

Getting help with LAN Manager 
Enhanced commands 

See 

Chapter 2, "Getting Started" 

Net Help 
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Net Load 
Purpose 

Syntax 

Comments 

Examples 

See Also 

Net load 

The net load command loads a profile. 

net load [[drive:path] filename] 

where 

drive:path 
Tells where the profile is stored. Without a drive letter and path, LAN Manager 
Enhanced assumes the profile is stored in the LANMAN.DOS\PROFILES directory. 

filename 
Is the name of the profile. If it has a .PRO extension, type only the name (without 
.PRO). Iffilename is omitted, the default profile, NETLOGON.PRO, is loaded. 

To restore connections made with the default profile, NETLOGON.PRO, type net load 
without options. 

The net load command gives you an easy way to make connections to a set of shared 
resources by loading a profile. 

Loading a profile connects your workstation to the resources specified in the profile and 
cancels all existing connections. To see a list of your workstation's connections, use the 
net use command. 

A profile is created with the net save command, which records the workstation's current 
connections in a profile file. 

If NETLOGON.PRO exists, LAN Manager Enhanced automatically loads it each time that 
you log on to the network. 

A. To load a profile called BUDGET.PRO, type 

net load budget 

B. To restore connections made with NETLOGON.PRO, type 

net load 

LAN Manager Enhanced reminds you of the existing connections and asks whether you 
want to cancel them. Type Y to load NETLOGON.PRO. 

For information about See 

Using profiles Chapter 6, "Customizing Your Workstation" 

Creating profiles Net Save 
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Net Log 
Purpose 

Syntax 

Comments 

The net log command controls or displays information about message logging. 

net log [[drive:path] filename I devicename] [/on I/off] 

where 

drive:path 
Tells where the message log file is stored. Without a drive letter and path, LAN 
Manager Enhanced assumes the file is to be stored in the LANMAN .DOS\LOGS 
directory. 

filename 
Is the name of the message log file. If it has a .LOG extension, type only the name 
(without .LOG). By default, messages are saved in the MESSAGES.LOG file. 

devicename 
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Is the name of a device at your computer connected to a printer queue. This name can 
be an LPT: devicename. Messages are printed as they're received. 

Ion 
Starts message logging. 

loff 
Stops message logging. 

To display information about message logging, type net log without options. 

Message logging is on by default when the Messenger service is started. 

The net log command controls the way messages are saved. You can stop and start 
message logging, change the name of the file that stores the messages, or have messages 
printed as they're received. 

You can read the message log file with the MS-DOS type command. 

You can stop message logging with the loff option and still view messages if the Netpopup 
service is running. But if the Netpopup service is stopped and message logging is off, your 
workstation emits a beep when a message is received but neither displays nor logs the 
message. 
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Examples 

See Also 

A. To see whether message logging is on and the message log filename, type 

net log 

B. To change the name of the message log file from MESSAGES.LOG to 
NOVEMBER.LOG, type 

net log november 

c. To print messages directly to the printer attached to LPTI, type 

net log 1 ptl : 

For information about See 

Net Log 

Logging messages Chapter 5, "Sending and Receiving Messages" 

Starting the Messenger service Net Start Messenger 
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Net Logoff 
Purpose 

Syntax 

Comments 

See Also 
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The net logoff command logs a user off from the network. 

net logoff 

The net logoff command removes a username and password at a workstation. Logging off 
does not stop the Workstation service. It simply ensures that no unauthorized person can 
use your username and password to gain access to shared resources. Logging off cancels 
all of a workstation's connections. 

You cannot log off if you are using a shared directory. Before using net logoff, you must 
change to a local drive on your computer. 

For information about See 

Starting LAN Manager Enhanced Chapter 2, "Getting Started" 

Logging on Net Logon 
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Net Logon 
Purpose 

Syntax 

Comments 

Net Logon 

The net logon command logs a user on to the network and sets the username, password, 
and domain at a workstation. 

net logon [username [password 1*]] [/domain:name] 

where 

username 
Is the name by which you identify yourself on the network (username can have as 
many as 20 characters). 

password 
Is the password for your account. 

* 
Produces a password prompt. The password is not displayed when you type it. 

Idomain:name 
Logs you on in a domain other than your workstation domain. This domain is called 
the logon domain. 

To be prompted for a username and a password, type net logon without options. 

The net logon command establishes your username and password at a workstation. These 
are used to log you on in a domain and grant you access to shared resources. Logging on 
also loads the default profile, NETLOGON.PRO, if it exists. 

Only one user can be logged on at a workstation at a time. 

You can use net logon to log on with another username or to log on in another domain, but 
you must first log off. 

About Usernames 

If you don't specify a username with net logon, a username is suggested. This username 
comes from the username entry of the LANMAN .INI file. If this entry is blank, the 
computername is suggested. 

About Passwords 

A password is a confidential word which, together with your username, establishes your 
identity and gives you access to resources. When you log on to the network or connect to a 
shared resource, your workstation sends your username and password specified with net 
logon to a server for verification. The server checks to see if it has an account for you and 
if the logon password you specified matches the password in your account. 
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LAN Manager Enhanced uses accounts in two ways. In a domain, a server maintains an 
account for each user. Once you log on, you can use all the resources in the domain to 
which your account is granted access. Accounts are also used by individual servers to limit 
access to their resources. 

What Is a Domain? 

A domain is a group of computers on the network. Domains are set up by an administrator. 
If you don't specify a /domain:name, LAN Manager Enhanced logs you on in your 
workstation domain, which is designated by the domain entry in the LANMAN .INI file. 

Your workstation domain probably includes the workstations and servers you most often 
work with. When you specify a /domain:name, you are logged on in a domain other than 
the workstation domain. This domain is called the logon domain. 

Servers visible in the workstation domain, the logon domain, and the domains listed in the 
othdomains entry of the LANMAN .INI file are displayed with the net view command. 
Your workstation will also receive messages sent to all of these domains. 

When you log on in a domain, you get access to most of the shared resources in the 
domain. Being logged on in one domain doesn't limit access to resources in other domains. 

A. To log on in your workstation domain, type 

net logon 

LAN Manager Enhanced asks you for a username, then asks for a password. 

B. To log on with the username felix and be prompted for a password, type 

net logon felix * 

You see the following display: 

Type your password: 

Your password is not displayed as you type it. 

C. To log on in the accounting domain with the username felix and the passwordjreddy, 
type 

net logon felix freddy Idomain:accounting 

For information about 

Logging on to and off from the 
network 

Logging off 

Changing your password 

See 

Chapter 2, "Getting Started" 

Net Logoff 

Net Password 
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Net Move 
Purpose 

Syntax 

Comments 

Example 

See Also 

The net move command moves files from a source to a destination. 

net move source [destination] 

where 

source 

Net Move 

Is the pathname of one or more files to be moved. Specify multiple filenames by using 
MS-DOS wildcard characters. 

destination 
Is the pathname to which source is moved. If more than one file is moved, destination 
must be a directory. If destination is omitted, files are moved to the current directory. 
LAN Manager Enhanced won't overwrite an existing file during a move. If 
destination is an existing file, the move is canceled. 

Use this command to move files between any two directories you have access to on the 
network. 

Moving a file is different from copying a file. Moving relocates the file; copying makes a 
duplicate. The moved file is given the date and time that the move occurred. 

You can move files between two remote computers. For instance, while working at 
workstation A, you can move files between servers Band C. You don't need to connect 
to shared directories to use net move. LAN Manager Enhanced makes the connections 
for you. 

To move all files in drive C's TEXT directory to the BUDGET directory on the \\ADMIN 
server's REPORTS shared directory, type 

net move c:\text\*.* \\admin\reports\budget 

For information about See 

Copying files Net Copy 
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The net name command adds or deletes a message alias, or displays a workstation's list of 
aliases. 

net name [alias [/add I/delete]] 

where 

alias 
Is the alias that you want to add or delete. An alias is a name to which a message can 
be sent. 

ladd 
Adds an alias to the workstation. Typing ladd is optional; typing net name alias 
performs the same task. 

Idelete 
Removes an alias from the workstation. 

To display a list of aliases in use at the workstation, type net name without options. 

A workstation can have three kinds of aliases, each receiving messages: 

• The workstation's computername, which is added when the Workstation service is 
started 

• Your username, which is added when you log on, provided your are not logged on 
elsewhere on the network 

• Aliases for messaging, which are added with net name 

Receiving Messages 

Messages can only be received by a workstation if the Messenger service is running. If the 
Netpopup service is also running, a message box displays the message on your screen. If 
message logging is on, the message is sent to the message log. If the Netpopup service and 
message logging are both off, you will only hear a beep when your workstation receives a 
message. The message is neither saved nor logged in the message log. 

A workstation receives messages sent to any of its aliases. A user does not have to be 
logged on at the workstation for the aliases at the workstation to receive messages. 

Adding and Deleting an Alias 

You can't add an alias to your workstation if it is already in use on the network. Similarly, 
you can't start the Workstation service with a computername that is being used as an alias 
at another workstation. 
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Net Name 

You can log on with a usemame that is being used elsewhere as an alias, but the usemame 
isn't added as an alias to your workstation. Therefore, you will not receive messages for 
that usemame at your workstation. 

The Idelete option is used to remove an alias. You can delete any alias in use at your 
workstation except the computername. 

Logging off deletes your username alias. Other aliases at the workstation, including the 
computername, still receive messages as long as the Workstation service is running. 

A. To view the list of aliases at your workstation, type 

net name 

B. To add the alias juliewo to your workstation, type 

net name juliewo 

C. To remove the alias juliewo from your workstation, type 

net name juliewo Idelete 

For information about See 

Messages Chapter 5, "Sending and Receiving Messages" 

Saving your messages in a file Net Log 

Sending messages Net Send 
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Net Password 
Purpose 

Syntax 

Comments 

The net password command changes the password for a user account on a server or in a 
domain. 

net password [f\\computername I Idomain:name] username oldpassword newpassword] 

where 

\"-L'omputername 
Is the server at which the password will be changed. 

username 
Is your username. 

oldpassword 
Is your current password. 

newpassword 
Is the new password, which can have as many as 14 characters. 

Idomain:name 
Specifies a domain other than the workstation domain in which the password will be 
changed. 

To be prompted for the name of the domain or server, your username, old password, and 
new password, type net password without options. 

User accounts are set up to control a user's access to shared resources on a server or in a 
domain. An account includes the username and password for a user. Accounts perform' 
similar functions on servers and in domains. The difference is that an account in a domain 
controls access to most of the resources shared on the servers in the domain, rather than 
just one server's resources. 

If you don't supply a \\.computername or a Idomain:name, LAN Manager Enhanced 
assumes you are changing the password for your account in the workstation domain. 

Keeping Passwords Confidential 

To keep your password confidential, you can type an asterisk (*) instead of typing a 
password. You are then prompted for your password, which is not displayed as you type it. 
LAN Manager Enhanced asks for the new password twice to ensure that it is correct. 

If you forget your password, see your administrator for a new one. You can then use 
net password to change the new password to one that you want. 
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See Also 

Net Password 

A. To change your password for the \\PRODUCTION server from petunia to daffodil (your 
usemame is robertch), type 

net password \\production robertch petunia daffodil 

To make the same change, but have LAN Manager Enhanced prompt you for a new 
password that won't be displayed when you type it, type 

net password \\production robertch petunia * 

B. To change your password in your workstation domain from carnation to orchid, type 

net password robertch carnation orchid 

C. To change your password in the accounting domain from magnolia to orchid, type 

net password Idomain:accounting robertch magnolia orchid 

For information about See 

Passwords Chapter 2, "Getting Started" 

Logging on with a password Net Logon 
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Net Pause 
Purpose 

Syntax 

Comments 

See Also 

The net pause command pauses a service or network connections. 

net pause {workstation I messenger I netpopup I drdr I prdr} 

where 

workstation 
Pauses all workstation connections. 

messenger 
Pauses the Messenger service. 

netpopup 
Pauses the Netpopup service. 

drdr 
Pauses all workstation connections to shared directories. 

prdr 
Pauses all workstation connections to shared printer queues. 
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Pausing the workstation puts it on hold and keeps your username and password active. The 
workstation is reactivated with the net continue command. 

Pausing connections allows you to use a devicename for a device at your computer instead 
of a shared resource. For example, the LPT 1: devicename can be connected to a shared 
printer queue with a laser printer. If LPTl: is also used for a dot-matrix printer at your 
computer, you can pause the network connection and print a quick draft at your computer. 
To send print jobs back to the shared printer queue, reactivate the connection with the 
net continue command. 

For information about 

Continuing a paused service or 
connection 

Stopping the Workstation service 

See 

Net Continue 

Net Stop 
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Net Print 
Purpose 

Syntax 

Comments 

Net Print 

The net print command displays information about a shared printer queue or controls a 
user's print jobs. 

net print {\\computernamef\sharename] I devicename} 

net print {\'v:'omputername I devicename} Uoh# [/hold I Irelease I Idelete]] 

where 

\'v:'omputername 
Is the name of the server sharing the printer queue(s). 

sharename 
Is the name of the printer queue. 

devicename 

joh# 

Is the name of the device at your computer assigned to the queue. 

Is the identification number assigned to a queued print job. Job numbers are unique on 
the server. 

Ihold 
Suspends a print job. A suspended print job is not printed until the Irelease option 
reactivates it. 

Irelease 
Reactivates a print job that is on hold. 

Idelete 
Cancels a print job. 

The net print command shows you where in a printer queue a print job is, and it lets you 
hold, release, or delete a job. 

Sending a job to a printer queue usually requires connecting to the queue with the net use 
command and then submitting the print job through an application program. But you can 
also send a job to a queue with the net copy or MS-DOS copy command. 

When you specify a computemame (for example, \\sALES) with net print, you get 
information about the printer queues being shared on that server. You don't need to make 
a connection to a queue to get information about it. The display is similar to the following: 
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Printer Queues at 
Name 

LASER Queue 
JACKST 
JENNYT 
JENNYT 

PRT Queue 
BENST 
JOHNOC 

\\SALES 
Job If 

3 jobs 
1 
3 
4 

2 jobs 
5 
6 

Size 

2509 
75 
75 

180 
512 

Status 

*Queue Active* 
Printing on LPT1 
Waiting 
Waiting 
*Queue Active* 
Printing on LPT2 
Waiting 

The columns of this display give the following information: 

Name 
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The sharename of each printer queue. Listed beneath the sharename are the usernames 
of people who sent print jobs. 

Job # 

Size 

The number of print jobs in each printer queue. Listed beneath the number of jobs is 
the unique identification number of each job in the queue. 

The size of each print job, in bytes. 

Status 
The status of either the printer queue or a print job. 

The status of a printer queue is controlled by an administrator. It can be 

• Active-Available to receive print jobs 

• Held-Suspended 

• Held until-Suspended until the time displayed 

• Pending delete-Being shut down 

• Error-Unavailable due to malfunction 

The status of a print job can be 

• Printing on devicename-Printing on the printer attached to the server's devicename 

• Spooling-Transferring into the printer queue 

• Waiting-Waiting for a printer to become available 

• Held-Held by the user with the Ihold option 

• Held on devicename-Held because an administrator held the queue 
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• Paused-Paused by the user or an administrator 

• Out of paper on device name-Stopped because paper ran out 

• Error on devicename-Stopped because of a malfunction 

• Offline on device name-Stopped because the printer is offline 

A. To see the printer queues shared on the \\PRODUCTION server, type 

net print \\production 

B. To learn about the DOTM queue on the \\PRODUCTION server, type 

net print \\production\dotm 

Net Print 

C. If your computer's LPTI: devicename is connected to the \\PRODUCTION server's 
LASER queue, display the contents of the queue by typing 

net print lptl: 

or 

net print \\production\laser 

D. To cancel a print job with the job identification number 7 on the \\PRODUCTION 
server connected to your computer's LPTI: devicename, type 

net print \\production 7 Idelete 

or 

net print lptl: 7 Idelete 

For information about 

Shared printers 

Copying a print job to a printer 
queue 

Connecting to a printer queue 

Viewing servers and queues 

See 

Chapter 4, "Using Shared Printers" 

Net Copy 

Net Use 

Net View 
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Net Save 
Purpose 

Syntax 

Comments 

Examples 

See Also 

The net save command creates a profile containing the workstation's connections to 
shared resources. 

net save [[drive:path] filename] 

where 

drive:path 
Tells where the profile is stored. Without a drive letter and path, LAN Manager 
Enhanced creates the profile in the LANMAN.DOS\PROFILES directory. 

filename 
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Is the name of the profile. Iffilename is typed without an extension, a .PRO extension 
is added. 

To save your workstation's connections in the default profile, NETLOGON.PRO, type 
net save without options. 

When you save a profile, LAN Manager Enhanced creates a file that contains a record of 
your workstation's current connections. When the profile is loaded, LAN Manager 
Enhanced makes the connections listed in the file. 

If you specify a profile that already exists, you see this warning message: 

This file already exists. Do you want to overwrite it? (YIN) [N]: 

By saving separate profiles, you can conveniently make quick connections to sets of 
shared resources that you use only at certain times. Or, if others use your workstation, each 
user can have a personal profile. 

Another use of net save is to save connections temporarily if for some reason you must 
stop the Workstation service. 

A. To save your workstation's current connections in NETLOGON.PRO, type 

net save 

B. A coworker uses your workstation regularly, and she uses shared directories that you 
don't use. She saves her profile under the name jane by typing 

net save jane 

For information about See 

Profiles Chapter 6, "Customizing Your Workstation" 

Loading profiles Net Load 
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Net Send 
Purpose 

Syntax 

Comments 

Net Send 

The net send command sends a message or short file to one or more users on the network. 

net send {alias I * I /domain[:name] I /broadcast} message 

where 

alias 
Is the username, computername, or other name to send the message to. 

message 

* 

Is the text of the message or the complete pathname of a text file (preceded by <) to be 
sent. 

Sends the message to all aliases in your workstation domain. 

/ domain[: name] 
Sends the message to all aliases in your workstation domain. If name is specified, the 
message is sent to all aliases in the specified domain. 

/broadcast 
Sends the message to all aliases on the network. 

Use the net send command to send a message to a user, users in a domain, or all users on 
the network. 

An alias must be active on the network to receive a message, and the Messenger service 
must be running on the receiving workstation. 

The size of a message that a workstation can receive is limited. This limit is set with the 
sizmessbufentry in the LANMAN.lNI file. By default, LAN Manager Enhanced 
workstations can receive messages of up to 256 bytes. Limit your messages to 256 bytes to 
ensure that the entire message will be received. 

The simplest way to send a message is to type it from the command line. A longer message 
can be typed over several lines by pressing ENTER after net send alias and after each line 
of text, then pressing CTRL+Z or F6 and ENTER to send the message. 

LAN Manager Enhanced provides several ways to broadcast a message (send it to many 
users). You can broadcast messages to all aliases in your workstation domain (use * or 
/domain), a different domain (/domain:name), or the entire network (/broadcast). 
Broadcast messages must be 128 characters or fewer. Use this feature with discretion. 
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A. To send the message "Meeting changed to 3 p.m. Same place." to the alias jackst, type 

net send jackst Meeting changed to 3 p.m. Same place. 

Another way to type this message is 

net send jackst 
Meeting changed to 3 p.m. 
Same place. 

To send this message, press CTRL+Z or F6, then ENTER. 

B. To send the small text file INVITE. DOC to all aliases in the legal domain, type 

net send Idomain:legal <invite.doc 

C. To inform everyone in your workstation domain that a party is being held in the 
cafeteria, type 

net send * There's a party in the cafeteria! 

For information about See 

Messages Chapter 5, "Sending and Receiving Messages" 

Saving or printing messages Net Log 

Adding aliases Net Name 

U sing the Messenger service Net Start Messenger 
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Net Start Messenger 
Purpose 

Syntax 

Comments 

Example 

The net start messenger command starts the Messenger service. 

net start [messenger [options]] 

where 

options are as follows: 

Ilogfile:pathname 
Assigns a pathname for the message log file. The default message log file 
pathname is LANMAN.DOS\LOGS\MESSAGES.LOG. 

Inummsgnames:number 
Sets the allowable number of message aliases for a workstation. The range is 
1-10; the default is 2 aliases. 

Isizmessbuf:bytes 
Sets the size (in bytes) of the message buffer, limiting the size of messages the 
workstation can receive. The range is 128-62000; the default is 256 bytes. 

To display a list of services that are running at the workstation, type net start without 
options. 

The Messenger service must be started in order for the workstation to receive messages. 

A message is sent to a workstation's alias with the net send command. LAN Manager 
Enhanced uses three types of aliases-a computername, a username, and an alias added 
with the net name command. 

There are two ways a workstation can receive messages sent to its aliases: 

• If the Netpopup and Messenger services are running, a message box displays each 
message on the workstation's screen . 

• If message logging is on, the incoming message is sent to a message log file or a printer. 
The net log command controls message logging. 

Changes made with the net start messenger command remain in effect only as long as the 
Messenger service is running. 

To start the Messenger service with a message buffer of 5120 bytes, type 

net start messenger Isizmessbuf:5120 
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See Also For information about 

Messages 

Logging messages 

Adding aliases 

Sending messages 

Starting the Netpopup service 

Starting the Workstation service 

See 

Chapter 5, "Sending and Receiving Messages" 

Net Log 

Net Name 

Net Send 

Net Start Netpopup 

Net Start Workstation 
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Net Start Netpopup 
Purpose 

Syntax 

Comments 

See Also 

The net start netpopup command starts the Netpopup service. 

net start [netpopup] 

To display a list of services that are running at the workstation, type net start without 
options. 

The Netpopup service lets you see messages as they arrive at your workstation. The 
Messenger service must be running for the workstation to receive messages. 

The message display is similar to the following: 

Message from EDWARDS to PETERP on 09-17-89 10:04 am 

Meeting at 1 p.m. in main meeting room. See you there! 

Press ESC to exit 

The message box disappears after one minute or when you press the ESC key. 

If message logging is on, the message is saved in the message log file. If message logging 
is off, messages are discarded after they're displayed. 

For information about See 

Messages Chapter 5, "Sending and Receiving Messages" 

Controlling network services Net Continue, Net Pause, Net Stop 

Logging messages Net Log 

Starting the Messenger service Net Start Messenger 
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Net Start Workstation 
Purpose 

Syntax 

The net start workstation command starts the Workstation service, optionally adjusting 
settings that affect the workstation's performance. 

net start [workstation [options]] 

Command options are grouped in the following five categories: 

Names 
Assign a name to your computer or specify parts of the network you'll work with. 

Times 
Specify how long the workstation waits for events to happen. 

Sizes 
Allocate memory or disk space for the workstation's use. 

Services 
Specify which services start with the Workstation service. 

Heuristics 
Adjust settings that determine how the workstation operates on the network. 

Each option corresponds to an entry in the [workstation] section of the LANMAN.lNI file. 
When you specify a net start workstation option, you override the corresponding 
LANMAN.lNI entry-but only until the next time that you start the workstation. 

Names 

/computername:name 
Is a unique name that identifies the workstation on the network. If the computemame 
matches any of the following on the network, the workstation will not start: 

• a computemame on anyone else's computer 

• a usemame on anyone else's computer 

• a domain name on the network 

• an alias on your computer or anyone else's 

Computemames can have 1-15 characters, including letters, numbers, and the 
following symbols: 

!#$%&'()_.@A_{ }~ 

/ domain :name 
Is the name of the workstation domain. The range is 1-15 characters. 
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Ilanroot:name 
Is the name of the root directory in which LAN Manager Enhanced software is stored. 
The default is LANMAN .DOS. 

lothdomains:name[, ... ] 
Specifies one or more domains that the workstation belongs to (as many as four, 
separated by commas). 

Iwrknets:number 
Specifies one or more networks in which the workstation participates. Networks are 
represented by LANA numbers 0-254 and are separated by commas. 

Times 

Ichartime:msec 
Specifies the number of milliseconds that LAN Manager Enhanced collects data 
before sending it to a named pipe. If Icharcount:bytes is satisfied first, LAN Manager 
Enhanced acts on that entry. The range is -1 (never) to 65535000; the default is 250 
milliseconds. 

Icharwait:sec 
Specifies the number of seconds that LAN Manager Enhanced waits for a named pipe 
to become available. The range is 0-65535; the default is 128 seconds. 

Ikeepconn:sec 
Specifies the number of seconds that LAN Manager Enhanced maintains a connection 
you're not using before breaking it. The range is 1-65535; the default is 600 seconds. 

Ikeepsearch:sec 
Specifies the number of seconds that LAN Manager Enhanced maintains a directory 
search request before discarding it. The range is 1-65535; the default is 600 seconds. 

Sizes 

Icharcount:bytes 
Specifies the amount of data that LAN Manager Enhanced collects before sending it 
to a named pipe. If Ichartime:msec is satisfied first, LAN Manager Enhanced acts on 
that entry. The range is 1-65535; the default is 16 bytes. 

Ihimem: {yes I no I optional} 
Specifies whether high memory allocation is used by the workstation. If optional is 
selected, the workstation determines when to use high memory allocation based on the 
hmamin entry of HIMEM.SYS (see the Microsoft LAN Manager Installation Guide). 
The workstation must have an expanded memory board and the appropriate device 
dri ver installed to use yes or optional. The default is no. 

Ikeepapis: {yes I no} 
Specifies whether LAN Manager Enhanced application program interfaces (APIs) are 
available to application programs. If no is selected, only named pipe APIs are 
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available; the LAN Manager Screen and some LAN Manager commands will not 
work. Note that if APIs are not desired, the Setup program should be used to reinstall 
LAN Manager Enhanced without APIs, or to install LAN Manager Basic. The default 
is yes. 

llim: I yes I no I 
Specifies whether LIM expanded memory is used by the workstation. The workstation 
must have LIM version 4.0 installed to use yes. The default is yes. 

Imailslots: I yes I no} 
Determines whether the workstation can receive second-class mailslots and server 
announcements. The default is yes. 

Imaxcmds:n 
Specifies the number of NetBIOS commands LAN Manager Enhanced workstation 
software can run simultaneously. The range is 5-255; the default is 11 NetBIOS 
commands. 

Imaxthreads:n 
Specifies the number of processes that can use LAN Manager simultaneously. The 
range is 10-254; the default is 20. 

Inumbigbuf :n 
Specifies the number of big buffers the workstation uses to receive large files or 
amounts of data from servers. Buffer size is set with the Isizbigbuf entry. The range is 
0-255; the default is 0 buffers. 

Inumcharbuf:n 
Specifies the number of character and pipe buffers the workstation uses. The range is 
0-15; the default is 2 buffers. 

Inumdgrambuf:n 
Specifies the number of buffers available for receiving information (datagrams) from 
a server. The range is 3-112; the default is 3 buffers. 

Inummailslots:n 
Specifies the number of mailslots available on the workstation. The range is 0-255; 
the default is 2 mailslots. 

Inumresources:n 
Specifies the maximum number of connections to shared resources allowed on the 
workstation at a time. The range is 1-255; the default is 9 connections. 

Inumservers:n 
Specifies the maximum number of servers to which the workstation can have active 
connections at a time. The range is 1-25'5; the default is 9 servers. 
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Inumservices:n 
Sets the size of the internal service table. This number should be greater than or equal 
to the number of entries in the [services] section of the LANMAN.INI file. The range 
is 1-255; the default is 5 services. 

Inumviewedservers:n 
Specifies the maximum number of servers that can be viewed with the net view 
command. The range is 0-255; the default is 50 servers. 

Inumworkbuf:n 
Specifies the number of buffers the workstation uses. The range is 3-50; the default is 
5 buffers. 

Isizbigbuf:bytes 
Specifies the size of big buffers used to receive large files or amounts of data. The 
Inumbigbuf entry sets the number of buffers. The range is 0-65535; the default is 
4096 bytes. 

Isizcharbuf:bytes 
Specifies the size in bytes of each character and pipe buffer. The range is 64-4096; 
the default is 128 bytes. 

Isizworkbuf:bytes 
Specifies the size in bytes of each workstation buffer. The range is 64-4096; the 
default is 1024 bytes. 

Services 

Iwrkservices:service[, ... ] 
Lists LAN Manager Enhanced services that start automatically when the Workstation 
service starts. Names "are separated by commas. Service names cannot be abbreviated. 

Heuristics 

Iwrkheuristics:string 
Are settings for fine-tuning the workstation's performance. For a description of each 
heuristic, see the Microsoft LAN Manager Administrator's Reference. 

If you're accustomed to using Microsoft Networks for MS-DOS version 1.0 or 
IBM® PC-LAN version 1.2, you can still use the following net start workstation options: 

Ib:n or Inbc:n 
Sets the number of workstation buffers (same as Inumworkbuf:n). 

Iz:n or Inbs:n 
Sets the size of the workstation's buffers (same as Isizworkbuf:bytes). 
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Comments 

Example 

See Also 

Workstation can be abbreviated as wksta, work, redirector, redir, or rdr. You must 
start the Workstation service to use LAN Manager Enhanced. 

To display a list of services that are running at the workstation, type net start without 
options. 

When assigning a computername while starting the Workstation service, typing 
/computername:name is optional; typing net start workstation computername performs 
the same task. 

To start a workstation with the computername \\FINANCIAL and the logon domain legal, 
type 

net start workstation finance Idomain:legal 

For information about 

Starting LAN Manager 

Pausing the Workstation service 

Stopping the Workstation service 

The LANMAN.INI file 

See 

Chapter 2, "Getting Started" 

Net Pause 

Net Stop 

Microso./f LAN Manager Administrator's 
Reference 
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Net Stop 
Purpose 

Syntax 

Comments 

See Also 

Net Stop 

The net stop command stops the Workstation service. 

net stop workstation 

Stopping the Workstation service cancels any network connections the service is using and 
logs you off from the network. It also stops any other services that are running. 

Stopping the Workstation service differs from pausing it. Pausing it puts the service on 
hold and suspends any network connections. Before stopping the Workstation service, you 
may want to consider saving your current connections in a profile using net save. That 
way, you can easily restore the connections by using net load. 

Stopping the Workstation service does not remove software from your computer's 
memory. LAN Manager Enhanced is a "Terminate and Stay Resident" (TSR) program, 
which means that when it stops, it stays in your computer's memory. If other TSR 
programs are loaded into your computer's memory, the net stop command may not work. 

For information about 

LAN Manager Enhanced services 

Loading profiles 

Saving profiles 

Starting services 

See 

Chapter 2, "Getting Started" 

Net Load 

Net Save 

Net Start Messenger, Net Start Netpopup, Net 
Start Workstation 
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Net Time 
Purpose 

Syntax 

Comments 

Examples 
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The net time command synchronizes the workstation's clock with a server, or displays the 
time and date for a server or domain. 

net time l'-\computername I Idomain[:name]] [/set] 

where 

\\computername 
Is the name of the server you want to check or synchronize with. 

Idomain[:name] 

Iset 

Displays the time and date at your workstation domain controller or synchronizes with 
that server. Use name to specify a different domain. 

Synchronizes the workstation's clock with that of the specified server or domain. 

To display the current date and time for the server designated as the network's official 
time source, type net time without options. 

This command provides a way to check whether your workstation's clock is properly 
synchronized with the clocks at servers. 

A. To see the time and date for the domain controller of the accounting domain, type 

net time Idomain:accounting 

B. To set your workstation's clock to the time and date on the network's designated time 
server, type 

net time Iset 
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Net Use 
Purpose 

Syntax 

Comments 

Net Use 

The net use command connects a workstation to or disconnects a workstation from a 
shared resource, or displays information about workstation connections. 

net use [devicename] r\\computername"sharename [passwordJ] 

net use {devicename I \Y'omputername\Sharename} Idelete 

where 

devicename 
Assigns a name to connect to the resource or specifies the devicename to be 
disconnected. LAN Manager Enhanced uses two kinds of devicenames: disk drives 
(D: through Z:) and printers (LPTI: through LPT3:). 

\Y'omputername 
Is the name of the server sharing the resource. 

\share name 
Is the name of the resource. 

password 
Is the password needed to use the resource. To be prompted for the password, type an 
asterisk (*) instead of the password. The password will not be displayed when you 
type it. 

Idelete 
Cancels a network connection. 

To list the workstation's connections, type net use without options. 

Connecting your workstation to a shared resource lets you use the resource as if it were 
attached to your computer. 

For example, net use can connect your workstation to a shared printer queue that uses a 
high-quality printer. When you use an application program, such as Microsoft Excel, you 
can print files on the printer by directing print jobs to the devicename assigned to the 
queue. 

NOTE You can use shared resources without making a connection with net use. The connection is 
made automatically by MS-DOS or by some network programs when you specify the network path of 
the resource with a command. But, if the resource is protected by a password, you must establish 
access with net use. You don't need to assign a devicename to establish access. Just type net use, the 
network path of the resource, and the password. 

You cannot delete a connection to a shared directory if it's your current drive. You must 
first change to another drive. 



Net Use 

Viewing Your Workstation's Connections 

When you type net use without options, you get information about the workstation's 
connections. You see a display similar to the following: 

Status 

OK 
01 SCONNECTEO 
ERROR 

Loca 1 name 

M: 
G: 
LPTl : 

The "Status" of a connection can be 

• OK-The connection is active. 

Remote name 

\\FINANCIAL\SCRATCH 
\ \PRODUCTION\C 
\ \PRINTl \LASER 

• Disconnected-The connection is suspended by the server but will be reestablished 
when you use it. 

• Paused-The connection is paused by the workstation. 

• Error-The connection has ended and must be deleted. 
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"Local name" is the devicename assigned to the resource. "Remote name" is its network 
path. 

There are two ways to get information about a connection: 

• Type net use devicename. 

• Type net use and the network path of the resource. You must type this command twice: 
first to establish a connection to the resource, then to get information about it. 

Either method produces a display similar to the following: 

Local name 
Remote name 
Resource type 
Status 
if Opens 
HConnections 

LPTl : 
\ \PRINTl \LASER 
Print 
OK 
o 

"Resource type" is the type of resource being used (Disk or Printer). "#Opens" is the 
number of files currently open on this connection. "#Connections" is the number of 
connections the workstation has to the resource. 
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Examples 

See Also 

Net Use 

A. To assign the devicename E: to the LETTERS directory on the \\FINANCIAL server, 
type 

net use e: \\financial\letters 

B. To assign the devicename LPTI: to the LASER2 printer queue on the \\ACCOUNTING 
server, type 

net use lptl: \\accounting\laser2 

C. To cancel your connection to the \\ACCOUNTING\LASER2 printer queue connected to 
LPTI:, type 

net use lptl: /delete 

D. To establish access to the \\FINANCIAL server's SCRATCH shared directory, which 
requires the password meteor, type 

net use \\financial\scratch meteor 

E. To cancel your connection to the \\FINANCIAL\sCRATCH shared directory, type 

net use \\financial\scratch /delete 

For information about See 

Making connections Chapter 2, "Getting Started" 

Restoring a set of connections Net Load 

Pausing and continuing connections Net Pause, Net Continue 

Saving connections Net Save 



Net View 

Net View 
Purpose 

Syntax 

Comments 

The net view command displays a list of servers or displays resources that a server is 
sharing. 

net view f\\computername] 

where 

\\computername 
Specifies the server whose shared resources you want to view. 
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To display a list of servers in your workstation domain, logon domain, and other domains, 
type net view without options. 

When you type net view without options, you see a list of servers similar to the following: 

Sr::rver Name Remark 

\ \PRODUCTION 
\\PRINTl 
\\SALES 

Production file server 
Printer room, first floor 
Sales records and lists 

When you specify a server with net view, you see a list of resources the server is sharing. 
The display looks similar to the following: 

Sharr::d Pr::s0urces at \\PRINTI 
PrintEr r00m, first floor 

Sharename Type Used as 

PRT Print LPT2: 
FAST PRT Print LPTl : 
D Disk R: 

Comment 

Printer pool 
Hi gh pri ority 
Drive D Root 

The columns give the following information: 

Sharename 
The name of the resource. 

Type 
The type of resource being shared. 

Used as 

printer 

The local devicename (if any) assigned to the resource. 

Comment 
An optional comment about the resource, supplied by an administrator. 
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Examples 

See Also 

A. To see a list of servers in your domain, type 

net view 

B. To see a list of the resources shared on the \\PRODUCTION server, type 

net view \\production 

For information about 

Shared resources 

Using a resource shared on a server 

See 

Chapter 2, "Getting Started" 

Net Use 

Net View 
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Net Who 
Purpose 

Syntax 

Comments 

Example 

See Also 
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The net who command lists users logged on in a domain, at a server, or at a workstation. It 
also lists information about a user. 

net who [/domain:name I \\computername I username] 

where 

\ \compute rname 
Is the name of the server whose users you want information about. 

username 
Is the name of the user you want information about. 

Idomain:name 
Lists users on a domain other than the domain in which you're logged on. 

To display information about users in the logon domain, type net who without options. 

When you type net who without options, you see a list of users logged on in your logon 
domain. The display looks similar to the following: 

Users on Domain HEADOTRS 

Time since 
Username Workstation Logon Full Name 

ABIGAIL PRODUCTION 10:11:45 Abi gai 1 Martin 
ARNIEG FINANCIAL 06:19:00 Arnold Gates 
PHILB SALES 11:23:13 Ph i 1 Bates 

The "Workstation" column lists the computemame of the user's workstation. 

NOTE The net who command provides information about servers using LAN Manager version 2.0. 
Servers using previous versions of LAN Manager provide information about users connected to it only 
to users with administrative privileges on the server. 

To see a list of users currently logged on in the marketing domain, type 

net who Idomain:marketing 

For information about See 

Displaying a list of servers Net View 





Par t 3 
LAN Manager Basic 

Part 3 explains how to use a LAN Manager Basic workstation to perfonn network tasks. It 
includes procedures for starting the workstation, getting help, and using shared resources. 
Additionally, LAN Manager Basic commands are explained in detail. 
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Chapter 8 

Using LAN Manager Basic 

This chapter explains how to start and use LAN Manager Basic, get online help, connect to 
local-area network directories and printers, and print jobs over the network. Instructions 
for viewing, pausing, and continuing your workstation's network connections are included. 
For information about LAN Manager Enhanced, see Part 2, "LAN Manager Enhanced." 

Starting LAN Manager Basic 
To use LAN Manager Basic, you must start the Workstation service, which loads software 
into your computer's memory that lets you connect to and use network resources. When 
you start the workstation, you supply a unique computername. This computername 
identifies your workstation to servers . 

• To start the workstation: 

1. Get your computername from your administrator. 

2. Type net start workstation followed by your computername. 

For example, if your computemame is johnw, start the workstation by typing 

net start workstation johnw 

(Note that workstation can be abbreviated as wksta, redirector, or rdr.) 

Several messages appear as the workstation starts. When the workstation is started, you'll 
see this message: 

Command completed successfully. 

Once the workstation is started, it remains running until you turn off the computer. 

If you specify a computername that is already being used on the network, the following 
error message is displayed: 

System error. 

123 
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If you receive this message, the workstation is started, but it does not have a 
computemame and you cannot use the workstation. See your administrator to get a valid 
computemame. Then use the net name command to assign the computemame . 

• To assign a computemame when the workstation has been started but no computemame 
has been assigned, type net name followed by a valid computemame. 

For example, to assign the computemame johnwa, type 

net name johnwa 

You can verify a workstation's computemame after the workstation is started by typing 
net name. A display similar to the following appears: 

Name Type 

JOHNWA COMPUTER NAME 

Once a valid computemame is assigned, it cannot be changed. You must tum off the 
computer and restart the workstation to assign a different computemame. 

Getting Help 
LAN Manager Basic gives you two kinds of help: a listing of all the commands for which 
help is available or information about a specific command. 

To see a list of LAN Manager Basic commands and an explanation of syntax, type 
net help. 

There are two ways to get help with a specific command: 

• By typing net help followed by the command name (without typing net as part of the 
command name) 

• By typing the full command name followed by help 

For example, you can type 

net help print 

or 

net print help 

Both commands display the same information. 
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Using Shared Directories 
LAN Manager Basic lets you use a shared directory in much the same way you would use 
a directory or disk drive on your computer. The files and application programs on a shared 
directory can be used as though they were stored on your computer. 

LAN Manager Basic lets you gain access to shared directories in two ways. You can 
connect your workstation to a shared directory by assigning a devicename to it. This 
concept is illustrated in Figure 8.1. You can also specify the shared directory as part of a 
pathname in some MS-DOS commands. These procedures are explained in the following 
two sections. 

Workstation Server 

D D 
[~l 

G:I drive 

~. 

l D:I drive 

Figure 8.1 Using a shared directory 

In both cases, the shared directory is identified by a network path. A network path is a 
server's computemame followed by a sharename. A sharename is a name that identifies a 
shared resource (directory or printer queue). Two backslashes (\\) precede the 
computemame, and another backslash precedes the sharename. 

For instance, \\PRODUCTION\REPORTS specifies a network path for the REPORTS 
shared directory on the \\PRODUCTION server. 

Connecting to a Shared Directory 
You can connect your workstation to a shared directory by assigning a disk drive 
devicename to it. 

A disk drive devicename is a drive letter followed by a colon (for example, D:). You use 
the devicename to gain access to the shared directory just as you use A: to gain access to a 
floppy disk drive on your computer. Devicenames A: through Z: are available. 
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NOTE If you assign a devicename of a disk drive on your computer (for example, A:), your 
workstation recognizes the network connection-not the local drive-unless the network connection is 
paused or disconnected. Avoid assigning the C: devicename. 

• To connect to a shared directory, type net use followed by a disk drive devicename, a 
space, and the network path of the directory. 

For example, to assign the S: devicename to the MIDWEST shared directory on the 
\\sALES server, type 

net use s: \\sales\midwest 

If you make a mistake in typing a command or you specify an incorrect network path 
when connecting to a shared directory, the following error messages may appear: 

Connection refused or syntax error 

Network name not found 

Some resources require you to supply a password to make a connection. If you don't 
supply a password when one is required, the following error message appears: 

Access denied 

To learn how to supply passwords, see the "Using Passwords" section. 

Once a connection is established, you no longer need to specify the network path to gain 
access to the shared directory. Instead, specify the devicename you assigned to the 
directory. 

For instance, if S: is assigned to the \\sALES\MIDWEST directory, S: represents the 
network connection in the same way C: represents your computer's hard disk drive. You 
can change the current drive to S: and use the shared directory as though it were one of 
your computer's disk drives. 

Using Passwords 
You may need to type a password with net use to gain access to a shared directory . Your 
administrator can give you the correct password. 

Once you know the correct password, there are two ways to supply it: 

• By typing the password at the end of the net use command. 

For example, to supply the password region while assigning S: to the MIDWEST shared 
directory on the \\sALES server, type 

net use s: \\sales\midwest region 

• By typing an asterisk (*) instead of the password at the end of the command line. LAN 
Manager Basic then prompts you for a password. 
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To use this method with the preceding example, type 

net use s: \\sales\midwest * 

The following prompt appears: 

Password: 

Type the password at the prompt. The letters don't appear on the screen as you type, 
keeping the password confidential. 

Using MS-DOS Commands with Shared Directories 
The network path of a shared resource can be used as part of a pathname in some MS-DOS 
commands. In this case, LAN Manager Basic connects to the server sharing the directory 
when the command is performed, provided the directory doesn't require a password. 

You don't need to assign a devicename to a shared directory when the network path is 
used as part of an MS-DOS command. But if a devicename is assigned, you can specify 
the devicename rather than the network path in the command. 

You can also use a file in a shared directory with any application program that runs under 
MS-DOS. For example, to edit the LIST.DOC file in the \\sALES\MIDWEST directory 
with Microsoft Word, type 

word \\sales\midwest\list.doc 

NOTE If you want to use a shared directory in an MS-DOS command but the directory requires a 
password, you must type net use, the network path, and the password. You don't need to specify a 
device name. 

You cannot use network paths with the following MS-DOS commands: 

• dir 

• copy 



128 Microsoft LAN Manager User's Guide for MS-DOS 

The following commands, which read from and write to the disk, cannot be used with 
shared directories and their files: 

• chkdsk 

• diskcopy 

• format 

• join 

• recover 

• subst 

• sys 

If you try to use a command that reads to or writes from the disk with a shared directory, 
the following message appears: 

Cannot [command] a Network drive 

where [command] is the name of the command you typed. 

Disconnecting from a Shared Directory 
You can disconnect your workstation from a shared directory when you are finished using 
it or when you want to assign the devicename to another resource. 

• To disconnect your workstation from a shared directory, type net use followed by the 
devicename and Idelete. (The Idelete option can be abbreviated as Id.) 

For example, to disconnect D: from a shared directory, type 

net use d: Idelete 

Using Shared Printers 
With LAN Manager Basic, you can use shared printers by connecting your workstation to 
a shared printer queue. 

A printer queue manages print jobs. It collects print jobs and sends them to a printer in the 
order they're received. Incoming jobs are held in the queue until the printer is ready to 
print them (see Figure 8.2). 
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Workstations 

Server 

Printer Queue Printer 

D 
/11111111 

Figure 8.2 Using a shared printer queue 

When you connect your workstation to a shared printer queue, you send print jobs to the 
queue just as you would send print jobs to a printer attached to your computer. 

Connecting to a Shared Printer Queue 
Connect your workstation to a printer queue by assigning a devicename. Devicenames 
LPTl: through LPT3: are available. 

• To connect your workstation to a printer queue, type net use followed by the 
devicename and the network path of the printer queue. 

For example, to assign LPTl: to the PRINTI printer queue on the \\FINANCIAL server, 
type 

net use lptl: \\financial\printl 

If you use a devicename that is also attached to a printer at your workstation, your 
workstation will recognize only the network connection when you use the devicename. To 
get your workstation to recognize the printer that is attached to your computer, you must 
disconnect or pause the connection to the shared printer queue. 

NOTE You may need to supply a password with net use to gain access to a shared printer queue. 
See the "Using Passwords" section, earlier in this chapter. 

Printing over the Network 
Once you have assigned a devicename to a shared printer queue, there are two ways to 
print a file over the network. You can print a file from an application program or send a 
file directly to the devicename. 
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• To print a file from a software application, set up the application to print to the 
devicename you assigned to the shared printer queue. Then print as you normally would. 

• To send a file to a devicename assigned to a printer queue, type net print followed by 
the filename and then the devicename. 

For example, to send the STATUS.DOC file to the printer queue connected to LPTl:, 
type 

net print status.doc lpt1: 

Viewing the Status of a Print Job 
You can view the contents of a shared printer queue connected to a devicename, or you 
can view the contents of all queues on a server. 

• To view the contents of a shared printer queue connected to a devicename, type 
net print followed by the devicename. 

For example, to view the printer queue connected to LPT 1:, type 

net pri nt 1 ptl: 

• To view the contents of a server's printer queues, type net print followed by the 
computemame of the server. 

For example, to view the contents of printer queues on the \\FINANCIAL server, type 

net print \\financial 

You don't need a connection to a server to view the contents of its queues. When you 
specify either a devicename or a computemame, a display similar to the following appears: 

Pos 1D Size Date Time Name Status 

0'11 268 115'174 '15-1'1-9'1 16:2'1 ANDREWS Printing 
'1'12 269 65174 05-1'1-9'1 16:22 KA TI EMC Waiting 
'1'13 27'1 34594 '15-1'1-9'1 16:25 SETHJ Waiting 
'1'14 271 1'13465 '15-1'1-9'1 16:28 CAROLR Waiting 

For each print job, the position in the queue, identification number, size (in bytes), date, 
time, owner, and status are displayed. 
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Disconnecting from a Shared Printer Queue 
You can disconnect your workstation from a shared printer queue when you are done 
using the resource or when you want to use the connection for another resource. 

• To disconnect from a shared printer queue, type net use followed by the devicename 
and Idelete. (The Idelete option can be abbreviated as Id.) For example: 

net use lpt1: /d 

Listing Connections to Network Resources 
At any time, you can view your connections to directories and printer queues. 

• To view the status of your workstation's connections or the names of devicenames and 
resources you're using, type net use. 

A display similar to the following appears: 

Local Network 
Status Device Name 

D: \\FINANCIAL\SYS 
E: \\SALES\SUSANKO 
F: \\FINANCIAL\APPS 

ERROR LPTl : \\FINANCIAL\LASERJET 

The listing shows all of the network resources connected to your workstation. 

If "ERROR" appears in the "Status" column, the connection is no longer active or has 
been suspended by the server. You may need to delete the connection and connect to the 
resource again. 

Pausing and Continuing Connections 
Occasionally, you may want to pause network connections to use devicenames for your 
workstation's own disk drives or printers. 

• To pause connections to all shared directories, type net pause drdr. To pause 
connections to all shared printer queues, type net pause prdr. 

• To continue connections to all shared directories, type net continue drdr. To continue 
connections to all shared printer queues, type net continue prdr. 
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For example, if you've assigned your workstation's LPTI: devicename to a shared printer, 
you can't use LPTI: for a local printer. To pause this connection, type 

net pause prdr 

You can now use LPT 1: for the printer attached to your computer. Note that pausing one 
printer connection pauses all printer connections. 

When you want to use the shared printer again, type 

net continue prdr 

Your connections to shared printer queues are reactivated. 
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Basic Command Reference 

This chapter provides a reference page for each LAN Manager Basic command. The 
purpose and syntax for each command, as well as comments, examples, and 
cross-references, are provided on the command reference page. The command reference 
pages are arranged in alphabetical order. 

Command Summary 
The following LAN Manager Basic commands are described in this chapter: 

net continue 
Reactivates network connections suspended with the net pause command. 

net help 
Provides help with a specific command or lists commands for which help is available. 

net name 
Displays the computername assigned to a workstation or assigns a computername to a 
workstation. 

net pause 
Pauses connections to shared resources. 

net print 
Displays the contents of shared printer queues or prints a file. 

net start workstation 
Starts the workstation and sets the computername. 

net use 
Connects the workstation to or disconnects the workstation from shared resources, or 
displays a list of the workstation's network connections. 
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Net Continue 
Purpose 

Syntax 

Comments 

See Also 

Net Continue 

The net continue command reactivates network connections suspended with the net 
pause command. 

net continue {drdr I prdr} 

where 

drdr 
Continues the workstation's connections to all shared directories. 

prdr 
Continues the workstation's connections to all shared printer queues. 

The net continue command can be abbreviated as net cont. 

Wh~n you continue network connections, any local connections, such as a printer attached 
to port LPT 1 on your workstation, are suspended. 

For information about 

Pausing and continuing network 
connections 

Suspending connections to shared 
resources 

Connecting to a shared resource 

See 

Chapter 8, "Using LAN Manager Basic" 

Net Pause 

Net Use 
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Net Help 
Purpose 

Syntax 

Comments 

Examples 

See Also 

The net help command provides help with a specific command or lists commands for 
which help is available. 

net help [command] 

net [command] help 

where 

command 
Is the command you need help with. Command names are continue, name, pause, 
print, start, and use. 

To display information about how to get help, type net help. 

For help with a specific command, type net, the command name, and help, or type 
net help followed by the command name (do not repeat the word net as part of the 
command name). 

A. To view a list of LAN Manager Basic commands that you can get help with, type 

net help 

B. To get information about the net use command, type 

net help use 

or 

net use help 

For information about See 

Getting help Chapter 8, "Using LAN Manager Basic" 
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Net Name 
Purpose 

Syntax 

Comments 

See Also 

Net Name 

The net name command displays the computername assigned to a workstation or assigns a 
computername to a workstation. 

net name [computername] 

where 

computername 
Is the name assigned to the workstation. 

To display the workstation's computername, type net name. 

The computername identifies your workstation on the network. When you connect your 
workstation to a shared resource, the server sharing the resource checks the computername 
to verify that you are allowed access. A computername must be unique on the network. 

The computername is assigned with the net start workstation command unless you try to 
assign a name that is already being used on the network. In this case, the workstation will 
be started, but no computername will be assigned. If this occurs, use net name to assign a 
valid computername. 

If no computername is displayed when you type net name without options, the 
workstation was started without a valid computername. 

For information about See 

Computernames Chapter 8, "Using LAN Manager Basic" 

Setting computernames Net Start Workstation 
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Net Pause 
Purpose 

Syntax 

Comments 

See Also 

The net pause command pauses connections to shared resources. 

net pause { drdr I prdr} 

where 

drdr 
Pauses the workstation's connections to all shared directories. 

prdr 
Pauses the workstation's connections to all shared printer queues. 

Pausing a connection allows you to use a devicename for a device at your workstation 
instead of a shared resource. 
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For example, the LPTl: devicename can be connected to a shared printer queue. If LPTl: 
is also used for a printer attached to your computer, you can pause the network connection 
and print a file at your computer's printer. To send print jobs back to the shared printer 
queue, reactivate the connection with the net continue command. 

For information about 

Pausing and continuing network 
connections 

Continuing connections to shared 
resources 

See 

Chapter 8, "Using LAN Manager Basic" 

Net Continue 
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Net Print 
Purpose 

Syntax 

Comments 

Net Print 

The net print command displays the contents of shared printer queues or prints a file. 

net print {\Y.:omputername r--sharename] I device name} 

net print rtilename] devicename 

where 

\\computername 
Is the server sharing the printer queue(s). 

sharename 
Is the name of a printer queue. 

devicename 
Is the device at your workstation assigned to the printer queue. LPT 1: through LPT3: 
are available. 

filename 
Is the name of the file to be printed. 

Specifying the computername of a server displays the contents of its printer queues. You 
don't need to be connected to a server to view the contents of its printer queues. 

Specifying the devicename assigned to a printer queue displays the contents of that printer 
queue, allowing you to check the status of a print job after it's sent. 

Specifying either a computername or a devicename produces a display similar to the 
following: 

Pos 

001 
002 

ID 

268 
269 

Size Date Time Name Status 

115074 05-10-90 16:20 DANe Printing 
65174 05-10-90 16:22 JOHNSW Waiting 

This display shows the position, identification number, size (in bytes), date, time, owner, 
and status of each print job. 

The "Name" column lists the owner of the print job. If the job was sent from a LAN 
Manager Basic workstation, the computername is displayed. If the job was sent from a 
LAN Manager Enhanced or an MS OS/2 workstation, the user's usemame is displayed. 
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Examples 

See Also 

A. To examine the contents of printer queues at the \\FINANCIAL server, type 

net print \\financial 
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B. To send the REPORTS. DOC file to the printer queue connected to your workstation's 
LPTI: devicename, type 

net print reports.doc lptl: 

C. To check the status of a print job that has been sent to the printer queue connected to 
LPTI:, type 

net pri nt 1 ptl: 

For information about See 

Printing over the network Chapter 8, "Using LAN Manager Basic" 

Connecting to shared printer queues Net Use 
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Net Start Workstation 
Purpose 

Syntax 

Comments 

See Also 

The net start workstation command starts the workstation and sets the computername. 

net start workstation computername 

where 

computername 
Is the name assigned to the workstation. 

You can abbreviate workstation as wksta, redirector, or rdr. 

When you type net start workstation computername, LAN Manager Basic software is 
loaded into your computer's memory and the workstation is started. 

For convenience, the net start workstation command can be added to an 
AUTOEXEC.BAT file to start LAN Manager Basic automatically. 

Once started, the workstation remains running until the computer is turned off or restarted. 

For information about See 

Computernames Chapter 8, "Using LAN Manager Basic" 

Checking the computername Net Name 
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Net Use 
Purpose 

Syntax 

Comments 

The net use command connects the workstation to or disconnects the workstation from 
shared resources, or displays a list of the workstation's network connections. 

net use 

net use [devicename] f\\computername\sharename [password I *]] 

net use {devicename I \\computername\sharename} /delete 

where 

devicename 
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Assigns a name to a shared resource. There are two kinds of devicenames: disk drive 
devicenames (A: through Z:) and printer devicenames (LPTl: through LPT3:). 

\\computername 
Is the name of the server sharing the resource. 

sharename 
Is the name of the shared resource. 

password 
Is the password needed to use the shared resource. 

* 
Results in a prompt for the password. 

/delete 
Ends a network connection (/delete can be abbreviated as /d). 

To display a list of the workstation's connections, type net use. 

Connecting to a shared resource lets you use the resource as if it were attached to your 
computer. If you assign a devicename of a disk drive on your computer (for example, A:), 
your workstation recognizes the network connection-not the local drive-unless the 
network connection is paused or disconnected. 

For example, net use can connect your workstation to a shared printer queue with a 
high-quality printer. When you use an application such as Microsoft Excel, you can print 
files on the printer by directing print jobs to the devicename assigned to the queue. 

Ifa password is required to gain access to a shared resource, LAN Manager Basic sends an 
error message if the password is not supplied. If this occurs, obtain the password from your 
administrator and retype the command. You can type an asterisk (*) instead of the 
password to get a password prompt. As you type the password, the letters are not 
displayed, keeping the password confidential. 
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Examples 

See Also 

Net Use 

The net use command can be added to the AUTOEXEC.BA T file to connect to shared 
resources automatically. 

You cannot delete a connection to a shared directory if it's used as your current drive. You 
must first change to another drive. 

When typed without options, net use lists all of your workstation's network connections. 
The display looks similar to the following: 

Local Network 
Status Device Name 

M: 
ERROR LPTl : 

\\FINANCIAL\SCRATCH 
\\SALES\LASER 

This display lists the status, local devicename, and network path of each connection. 

If "ERROR" appears in the "Status" column, the connection is no longer active or has 
been suspended by the server. You may need to delete the connection and connect to the 
resource again. 

A. To assign the E: devicename to the LETTERS shared directory on the \\sALES server, 
type 

net use e: \\sales\letters 

B. To assign the LPTI: devicename to the LASER shared printer queue on the \\sALES 
server, type 

net use lptl: \\sales\laser 

C. To disconnect the LPTl: devicename, type 

net use lptl: Idelete 

D. To establish access to the \\FINANCIAL server's SCRATCH shared directory, which 
requires the password deposits, type 

net use \\financial\scratch deposits 

For information about See 

Shared directories Chapter 8, "Using LAN Manager Basic" 
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Appendix A 
Menu Commands 

This appendix gives a brief tour of the LAN Manager Screen. It describes information 
displayed on the screen and explains what you can do with each menu command. 

The LAN Manager Screen 
After you start the Workstation service, you can use the LAN Manager Screen. The screen 
is shown in Figure A.I. 
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Current focus 
Menu bar Workstation information 

"" View Message Config Accounts Help 
~ Current focus : \\1-2128 ~Your username .. PETERP 

Your conputernane \\1-2128 
Your donain . . . HEADQTRS 

Set current focus on [\\1-2128 ] 

Server nane Renark 

1I 1~'11 Im_Ullfl.._~.IIII'~"I.Ir.. •• U : 'f 

r 
ADMINSTR Adninistration server 1 FINANCE2 :::: 

FINANCIAL Finance dept printer server III! I MIS Printer server 

/1 
l MRKTING Marketing departnent 38£1 

PRODUCTION Production file server 
1\ SALES Sales records and lists I' 

J. 
I 

~ 

Press the ALT ke4 to select a nenu ~icrosoft LAN Manager 

( Message line 
Servers in the 10 g on and workstation domains Scroll bar 

Figure A.1 The LAN Manager Screen 

The fields of the LAN Manager Screen provide the following infonnation: 

Menu bar 
Displays the names of menus from which you can select menu commands. 

Current focus 
Shows the computername of your workstation or the server that is the focus of activity 
when using LAN Manager Screen commands. 

Workstation information 
Provides the following infonnation about your workstation: 

Your username 
The username specified when you logged on to the network. 

Your computername 
The computername specified when the workstation was started. 
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Your domain 
The name of your logon domain. This is the domain name specified when you 
logged on to the network. If you didn't specify a domain name, you 
automatically logged on in the workstation domain, which is specified in the 
LANMAN.INI file. Note that the workstation domain and the logon domain are 
the same. 

Servers in the logon and workstation domains 
Lists the servers in your logon and workstation domains. 

Scroll bar 
Lets you scroll through the servers in the list box with the mouse. 

Message line 
Provides a brief statement about the current menu, command, or task. 

View Menu 
The View menu commands let you view shared resources on the server of current focus, 
make connections to shared resources, view your workstation's connections, view 
information about users on the network, and exit the LAN Manager Screen. 

IWUDDI Message Config Accounts 

Available resources ... 
Printer queues ... 

Used resources ... 

Users on a server .. . 
Users on a domain .. . 

Exit F3 

'lour username " PE TERP 
'lour computer name \\1-2128 
'lour domain . .. HEADQTRS 

The following list describes the View menu commands: 

A vailable resources 

Help 

Displays the different types of resources available on the server of current focus. 
These resources include shared directories (disks) and printers. 

Printer queues 
Displays the printer queues on the server of current focus and the print jobs in each 
queue. 

Used resources 
Displays the resources that your workstation is connected to on the server of current 
focus. You can connect your workstation to resources shared by servers other than the 
server of current focus and by non-LAN Manager servers. 



148 Microsoft LAN Manager User's Guide for MS-DOS 

Users on a server 
Displays the users that are logged on at the server of current focus. 

Users on a domain 
Displays the users that are logged on in a domain. 

Exit 
Removes the LAN Manager Screen. 

Message Menu 
The Message menu commands let you send, log, and read messages, and add and delete 
aliases. 

View 'jrgt¥·"iiii5 Conf ig Accounts Help 
Curre Your usernaMe .. PE TERP 

IS Your cOMputernaMe \\1-2128 
Your dOMain . .. HEADQTRS 

Log Messages to file .. . 
Read Message log file .. . 

Aliases ... 

The following list describes the Message menu commands: 

Send a typed message 
Lets you send a message to one or more users on the network. 

Log messages to file 
Lets you select the log file that stores your messages, and pause and continue message 
logging. 

Read message log file 
Displays the messages in your message log file. 

Aliases 
Displays the message aliases on your workstation. You can add message aliases to and 
delete message aliases from your workstation. 
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Config Menu 
The Config menu commands let you log on, log off, use profiles, and view your 
workstation configuration. 

View Message IWffHIJ1I Accounts 
Current focus : 

Log on to LAN ... 
Log off fro~ LAN 
Load prof i Ie .. . 
Save prof i Ie .. . 

Workstation options ... 

userna~e .. 
co~puterna~e 
do~ain . . . 

The following list describes the Config menu commands: 

Log on to LAN 
Lets you log on to the network. 

Log off from LAN 
Lets you log off from the network. 

Load profile 

PETERP 
\\1-2128 
HEADQTRS 

Help 

Displays the profiles that you can load to make automatic connections to shared 
resources. 

Save profile 
Lets you save a record of the workstation's current connections as a profile. 

Workstation options 
Displays information about your workstation's configuration. 

Accounts Menu 
The Accounts menu commands let you view information about your account and change 
your password. 

View Message Conf ig '-lag.II"'A Help 
Current focus : \\1-2128 PETERP 

Iy a~e \\1-2128 
Change your password. . . HEADQTRS 
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The following list describes the Accounts menu commands: 

Your account 
Displays information about your account. 

Change your password 
Lets you change your password at a server. 

Help Menu 
The Help menu commands let you access different types of online help. 

View Message Config Accounts 
Current focus: \\1-2128 Your usernallle ....-----------, 

Your cOlllputern IG 
Your dOlllain . t----------I 

The following list describes the Help menu commands: 

General help Fl 

Keyboard 
Mouse 
Table of contents .. . 
Glossary of terllls .. . 

Using Help 
About LAN Manager ... 

Describes the LAN Manager Screen and how to use it. 

Keyboard 
Tells how to use the LAN Manager Screen with the keyboard. 

Mouse 
Tells how to use the LAN Manager Screen with the mouse. 

Table of contents 
Displays a list of tasks you can perform with the LAN Manager Screen. 

Glossary of terms 
Displays an alphabetical list of terms and definitions used with LAN Manager 
Enhanced. 

Using Help 
Explains how to use help. 

About LAN Manager 
Provides a brief description of LAN Manager. 



Appendix B 
Country Codes 

A country code in a user account defines the language in which messages are sent from a 
server to a user. Messages such as print notifications and alerts are sent from a server to a 
user's workstation. The country code does not affect the language of error messages and 
explanation messages generated by the workstation itself. 

The following table lists available country codes. The default value for the country code 
is o. If the default value is specified, messages are sent in the language used in the 
LANMAN\NETPROG\NET.MSG file. 

Country Code Country Code 

Asia 099 Latin America 003 

Australia 061 Netherlands 031 

Belgium 032 Norway 047 

Canada 002 Portugal 351 

Denmark 045 Spain 034 

Finland 358 Sweden 046 

France 033 Switzerland 041 

Germany 049 United Kingdom 044 

Italy 039 United States 001 

Japan 081 
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Glossary 
Account See User account 

Administrator The individual responsible for the 
local-area network. This person typically 
configures the network, maintains the network's 
shared resources and security system, creates user 
accounts, assigns permissions, and helps users. 

Alert message A message sent by a server to a 
LAN Manager Enhanced workstation informing the 
user of conditions that require attention. 

Alias A name used to receive messages at a LAN 
Manager Enhanced workstation. A workstation can 
have up to 15 aliases, including the computername 
and usemame. An alias must be unique on the 
local-area network. 

Application program A program used for a 
particular kind of work, such as word processing or 
database management. 

ASCII text A standard text file. See also Binary 
format. 

Basic See LAN Manager Basic. 

Batch file See Batch program. 

Batch program An executable program 
containing a group of commands that are performed 
whenever the batch program is run. MS-DOS batch 
programs always have the filename extension .BAT. 
A batch program called AUTOEXEC.BAT runs 
when you start MS-DOS. 

Binary format A series of binary digits (ones and 
zeros). See also ASCII text. 

Broadcast message A message sent to all users in 
a domain or on the local-area network. See also 
Messenger service. 

Buffer An area in a computer's memory that is 
used to store data. 

Check box An area in a LAN Manager Screen 
dialog box that has options you can set. 

Click To position the mouse pointer on a 
character, and press and release the left mouse 
button. 

Command An instruction that provides the 
necessary information for a computer or a program 
to perform a specific task. You type LAN Manager 
Basic commands at the operating system prompt. 
You type LAN Manager Enhanced commands at 
the operating system prompt or choose them from a 
menu on the LAN Manager Screen. 

Command button A word or phrase enclosed in 
angle brackets at the bottom of the LAN Manager 
Screen or a dialog box (for example, <Zoom> ). 
Choosing a command button carries out a task or 
leads to another dialog box. 

Command line The MS-DOS prompt. See also 
Command and Prompt. 

Command option See Option. 

Computername The name of a workstation or a 
server on a local-area network. In a network path, a 
server's computername is preceded by two 
backslashes (for example, \\sALES). 
Computemames must be unique on the local-area 
network. For LAN Manager Basic, the 
computername is used to identify your workstation 
to servers. 

Configuration The way the workstation, server, or 
local-area network is set up, including both 
hardware and software. 
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Connect To assign a name of a local device to a 
shared resource or to gain access to a shared 
resource with a LAN Manager command. See also 
Devicename and Shared resource. 

Connection The software link between a 
workstation and a shared resource. You make 
connections by assigning a local devicename on a 
workstation to a shared resource on a server. 
See also Session. 

Continue To restart a LAN Manager service that 
was paused. See also Pause. 

Country code A code that is included in a user's 
account and specifies the user's language. This 
code determines the language in which messages 
are sent from the server. 

Current focus The server or workstation that is 
the focus of activity when using the LAN Manager 
Screen. 

Cursor The lighted shape on the computer screen 
showing where the next character you type will 
appear. See also Pointer. 

Device A piece of hardware that is attached to a 
computer and performs a specific function. There 
are two types of devices--disks and printers. 
See Device driver. 

Device driver Software that enables a computer to 
recognize and use a device. 

Devicename The name of a device on your 
computer or the name of a device assigned to 
connect to a shared resource. The devicename is the 
name by which LAN Manager and your computer 
identify a disk device and a printer device. Two 
types of devicenames are used for local-area 
network connections: disk devicenames (for 
example, E:), and printer devicenames (for 
example, LPTl:). See also Disk device and 
Printer device. 

Dialog box A box that appears on the LAN 
Manager Screen when a menu command is chosen. 
Dialog boxes typically present a number of options 
from which you can choose. Sometimes choosing 
an option from one dialog box causes another 
dialog box to appear. 

Directory A table of contents for a disk. The 
directory listing includes filenames, file sizes, and 
the date when the file was created or last modified. 

Disk device A device that stores information. 
Disk devices are identified by their devicenames. 
See also Devicename. 

Disk directory See Directory. 

Disk drive devicename See Devicename and 
Disk device. 

Domain A group of devices, servers, and 
workstations grouped together to simplify network 
administration and security. Domains have names 
and every computer on the local-area network 
belongs to at least one domain. Being logged on in 
one domain does not limit access to resources in 
other domains to which you have access. See also 
Logon domain, Other domains, and Workstation 
domain. 

Domain controller The server that verifies a user 
is allowed to log on in a domain. This server 
maintains a master record of user accounts. 

Double-click To position the mouse pointer on a 
character, and press and release the left mouse 
button twice with a quick motion. 

Drag To position the mouse pointer on the 
character that will begin or end your selection; 
press and hold down the left mouse button while 
moving your pointer to the other end of the desired 
selection; and release the left mouse button. 



Enhanced See LAN Manager Enhanced. 

Error log A file that stores LAN Manager error 
messages received by a LAN Manager Enhanced 
workstation. 

Error message A message that appears on your 
computer screen after LAN Manager or MS-DOS 
detects a problem while trying to process an 
operation or a command. 

Field One of the five areas within a dialog box. 
See also Check box, Command button, Dialog box, 
List box, Option button, and Text box. 

File attribute MS-DOS file attributes are 
read-only and archive. These attributes can be 
assigned to MS-DOS files and directories using the 
MS-DOS attrib command. 

Filename A unique name for a file. It can be from 
one to eight characters in length and can be 
followed by a filename extension consisting of a 
period (.) and one to three characters. See also 
Filename extension. 

Filename extension A period (.) and one to three 
characters that can be appended to a filename. For 
example, LAN Manager Enhanced profile files 
have the extension .PRO. See also Filename. 

Forwarding messages See Message forwarding. 

Home directory A directory on a server that an 
administrator sets aside for your personal use. 

Initialization file The LANMAN.INI file. This 
file is used by the LAN Manager software to 
determine the default settings for the workstation. 
See also LANMAN.INI. 

LAN See Local-area network. 

LAN Manager A software program that expands 
the features of MS-DOS to enable your computer to 
join a local-area network. See also Local-area 
network. 
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LAN Manager Basic A version of LAN Manager 
that enables an MS-DOS computer to connect to 
local-area network directories and printers, and 
print jobs over the network. Using LAN Manager 
Basic, network tasks can be done from the 
command line only. 

LAN Manager Enhanced A version of LAN 
Manager that enables an MS-DOS computer to 
connect to local-area network directories and 
printers, print jobs over the network, send and 
receive network messages, and use profiles to 
automatically connect to network resources. Using 
LAN Manager Enhanced, network tasks can be 
done from the command line and from the LAN 
Manager Screen. 

LAN Manager Screen A menu-oriented, 
full-screen interface for LAN Manager Enhanced. 
With the LAN Manager Screen, you can use LAN 
Manager Enhanced without having to memorize 
command syntax. 

LANMAN.lNI An initialization file that determines 
default settings for computers on the local-area 
network. 

List box An area in a LAN Manager Screen 
dialog box containing a list of items from which 
you can select. See also Scroll, Scroll bar, and 
Scroll box. 

Local Refers to a resource attached to a user's 
computer. See also Remote. 

Local resource See Local. 

Local-area network A group of personal 
computers and other hardware, attached by cable, 
that lets users share information and equipment. 

Log A file containing a historical list of 
information. See also Error log and Message log. 
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log off To remove your username and password 
from a LAN Manager Enhanced workstation and 
cancel connections to resources, but not stop LAN 
Manager Enhanced services. 

log on To supply your username and password, 
which identify you as a user at a LAN Manager 
Enhanced workstation and as a member in a 
domain. See also Domain, Password, and 
Username. 

logon domain A domain (other than the 
workstation domain) that is specified when you log 
on with LAN Manager Enhanced. See also 
Domain, Other domains, and Workstation domain. 

logon password The password specified when 
logging on at a LAN Manager Enhanced 
workstation. See also Password. 

Menu A box that appears when you select a name 
from the menu bar on the LAN Manager Screen. A 
menu lists several commands from which you can 
choose. 

Menu bar The horizontal bar at the top of the 
LAN Manager Screen that lists the names of menus 
from which you choose commands. 

Menu command A command that can be chosen 
from a menu on the LAN Manager Screen. See also 
LAN Manager Screen, Menu, and Menu bar. 

Message alias See Alias. 

Message box A box that displays messages 
received at a LAN Manager Enhanced workstation 
when the Messenger and Netpopup services are 
running. See also Messenger service and Netpopup 
service. 

Message forwarding To use aliases to reroute 
messages from a LAN Manager Enhanced 
workstation to another workstation. See also Alias. 

Message line A message line displayed at the 
bottom of the LAN Manager Screen that provides 

information about the current menu, command, 
dialog box, or task. See also LAN Manager Screen. 

Message log A LAN Manager Enhanced file that 
can be used to store a workstation's messages as 
they are received. 

Message logging To save a LAN Manager 
Enhanced workstation's messages in a file. See also 
Error log and Message log. 

Messenger service A LAN Manager Enhanced 
service that enables a workstation to receive 
messages from other network users. This service 
also provides the ability to store messages in a 
message log file. See also Netpopup service. 

MS-DOS Microsoft Disk Operating System. This 
is the operating system on which LAN Manager 
Basic and Enhanced run. 

MS-DOS prompt See Prompt. 

Netpopup service A LAN Manager Enhanced 
service that displays messages on your computer 
screen as they arrive from other local-area network 
users or from LAN Manager. The Netpopup service 
requires that the Messenger service be running. See 
also Messenger service. 

Network path The computername of a server 
followed by the sharename of a shared resource. A 
server's computername is preceded by two 
backslashes (\\), and a sharename is preceded by 
one backs lash (for example, \\sALES\REPORTS). 
You connect your workstation to a shared resource 
by specifying a network path. See also 
Computername, Resource, and Sharename. 

Network resource A resource that is available to 
local-area network users. See also Resource and 
Shared resource. 

Option Part of a command that determines how 
the command or service works, but which is not 
required. 



Option button A button in a LAN Manager Screen 
dialog box from which you can select one option 
from a group of options. 

Other domains Domains other than the logon and 
workstation domains in which your LAN Manager 
Enhanced workstation is a member. See also 
Domain, Logon domain, and Workstation domain. 

Password A word that a LAN Manager Enhanced 
user supplies when logging on at a workstation (the 
logon password) or connecting to a shared resource. 
The password, together with the usemame, 
establishes the user's identity on the local-area 
network. See also Logon password. 

Path The name of one or more directories (for 
example, REPORTS\ACC1\NORTH). See also 
Pathname. 

Pathname The name of one or more directories 
followed by a filename. For example, the pathname 
of the MONTHL Y.RPT file in the 
REPORTS\ACC1\NORTH directory is 
REPORTS\ACC1\NORTH\MONTHLY.RPT. 

Pause To suspend a LAN Manager service. See 
also Continue. 

Permission A setting on a shared resource that 
determines which users can use the resource and 
how. 

Pointer A small graphic symbol that shows 
mouse users their location on the screen. The 
mouse pointer on the LAN Manager Screen is a 
small rectangular box. 

Pool A group of similar devices that receive 
requests from the same queue. 

Port A socket in the back of a hardware device 
(for example, a computer or printer) where a cable 
is plugged in. 

Print job A file sent to a printer queue to be 
printed. 
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Printer device A device that prints information. 
Printer devices are identified by their devicenames. 
See also Devicename. 

Printer queue A queue that manages and routes 
print jobs. 

Privilege A privilege level is assigned for each 
user account. The privilege level defines the range 
of action a user can have on the local-area network. 

Profile A file containing LAN Manager Enhanced 
commands that automatically connect a LAN 
Manager Enhanced workstation to a group of 
shared resources. 

Prompt The symbol that tells you an operating 
system or program is ready to receive a command. 
You type commands at the prompt. 

Remote Refers to a server, workstation, or 
resource that is not located where you are currently 
working. See also Local. 

Resource Something that is shared over the 
local-area network. This includes, but is not limited 
to, disk drives, directories, and printers. See also 
Shared resource. 

Scroll To move data or text up and down, or left 
and right, in a LAN Manager Screen dialog box. 

Scroll bar The shaded bar that appears at the right 
of some LAN Manager Screen list boxes. Use the 
scroll bar and the mouse to scroll through a list box 
that contains more information than can be shown 
in one screen. 

Scroll box The small box superimposed on the 
scroll bar that appears at the right of some LAN 
Manager Screen list boxes. The scroll box reflects 
the position of the information within the window 
in relation to the total contents of the list. See also 
Scroll bar. 

Server A computer on a local-area network that 
controls access to resources such as files and 
printers. A server can also be used as a workstation. 
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Service A program that is one of the main 
components of LAN Manager. 

Session A link between a workstation and a 
server. A session consists of one or more 
connections to shared resources. See also 
Connection. 

Setup program A program that installs LAN 
Manager Enhanced or Basic software on a 
workstation. 

Shared directory A disk directory on a server to 
which users of the local-area network have access. 
A shared directory contains files that are available 
to network users. 

Shared printer See Printer queue. 

Shared printer queue See Printer queue. 

Shared resource A resource available to users of 
the local-area network. See also Resource. 

Sharename A name that identifies a shared 
resource. See also Computername and Shared 
resource. 

Sharing The process by which resources are 
made available to local-area network users. 

Software The programs, routines, or instructions 
written in a computer language that instruct the 
computer to perform one or more tasks. 

Text box An area in a LAN Manager Screen 
dialog box where you type information. The text 
box mayor may not contain text. 

Title bar The place at the top of a LAN Manager 
Screen dialog box where titles appear. 

User Someone who uses the local-area network. 

User account A user's record on a server or in a 
domain that defines the hours during which the user 
can log on and controls the access that the user can 
have to resources in the domain. 

Username The name a LAN Manager Enhanced 
user types when logging on to the local-area 
network. This is the name by which the user is 
identified on the network. 

Wildcard character A character, used with 
MS-DOS directory commands, indicating that any 
character can occupy the position of the wildcard 
character. The wildcard characters are the asterisk 
(*) and the question mark (7). 

Workstation A computer with hardware and 
software that enable it to run LAN Manager. 

Workstation domain The domain into which a 
LAN Manager Enhanced workstation is logged by 
default. Unless another domain is specified during 
logon, LAN Manager Enhanced uses the 
workstation domain. See also Domain, Logon 
domain, and Other domains. 

Workstation service A LAN Manager service that 
enables a computer to use network resources and 
services. This service must be running for any other 
service to run. 
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and Enhanced. 

A 
Accounts menu 

Change your password command, 34 
Your account command, 33 

Accounts, user 
changing a password, 93 
viewing your account, 88 

Aliases, 61 

B 

adding and deleting, 61-62, 91 
forwarding, 100 
viewing, 91 

Batch programs, 37 
using commands in, 70 

c 
Clocks, computer 

synchronizing, 111 
Commands [B] 

viewing a list of, 135 
Commands, net, 73 

net access, 74-76 
net config workstation, 77 
net continue, 78 
net continue [B], 134 
net copy, 79-80 
net help, 81-82 
net help [B], 135 
net helpmsg, 83 
net load, 84 
net log, 85-86 
net logoff, 87 
net'logon, 88-89 
net move, 90 
net name, 91-92 
net name [B], 136 
net password, 93-94 
net pause, 95 
net pause [B], 137 
net print, 96-98 
net print [B], 138-139 
net save, 99 
net send, 100-101 

net start messenger, 102-103 
net start netpopup, 104 
net start workstation, 105-109 
net start workstation [B], 140 
net stop, 110 
net time, 111 
net use, 112-114 
net use [B], 141-142 
net view, 115-116 
net who, 117-118 
working with commands 

abbreviating, 69 
commands summary, 71 
commands summary [B], 133 
expediting a command, 69 
password requirements, 70 
use in batch programs, 70 

Computername [B] 
assigning, 136 
setting the computername at startup, 140 
viewing, 136 

Config menu 
Load profile command, 65 
Log off from LAN command, 36 
Save profile command, 64 
Workstation options command, 68 

Configuration, workstation, 68 
Connecting. See Directories, shared. Printer queues. 
Connections 

saving, 64 
viewing, 43, 112 

Connections [B] 
continuing, 131, 134 
pausing, 131, 137 
viewing, 131, 141 

Continuing a service. See Messenger service. 
Netpopup service. Workstation service. 
Controlling a service. See Messenger service. 
Netpopup service. Workstation service. 
Copying files. See Files 
Country codes, 151 
Current focus, 29 

159 
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o H 
Deleting. See Aliases 
Devicenames, 52 

for disk resources, 40 
assigning, 41 
viewing, 40 

for printer queues, 50 
Directories, shared 

changing permissions for, 74 
connecting to, 40, 43 
defined,39 
disconnecting from, 44--45 
making a onetime connection, 43 
using, 112 
viewing connections, 39--40 

Directories, shared [B], using, 125, 141 
Disconnecting. See Directories, shared. Printer 
queues. 
Disconnecting from printer queue. See Printer queues 
Disks, shared. See Directories, shared 
Display. See LAN Manager Screen 
Domains 

E 

belonging to, 106 
changing your password for a domain, 93 
defined,89 
logon domain, 88-89 
sending messages to domains, 100 
synchronizing clocks in, 111 
viewing servers in, 39, 115 
workstation domain, 88-89, 105 

Error messages, getting help with, 83 
Exiting LAN Manager Screen. See LAN Manager 
Screen 

F 
Files 

copying over the network, 44, 79 
moving over the network, 44, 90 

Files, shared 
changing permissions for, 74 
copying, 79 
moving, 90 
using, 112 
See also Directories, shared 

Finding users on network. See Users, viewing 

Help system, 18,27 
displaying a Help message box, 28 
FI key, 27 
for error messages, 28, 83 
for net commands, 28, 81 

Help system [B], 124, 135 
Home directory, defined, 75 

l 
LAN Manager 

quitting, 36 
starting, 19-21 
starting automatically, 37 

LAN Manager Screen, 17 
closing dialog boxes, 35 
controlling the display, 70 
exiting, 35 
starting LAN Manager using, 19 

LAN Manager services. See Messenger service. 
Netpopup service. Workstation service. 
Language of messages 

assigning, 151 
LANMAN.INI file, defined, 68 
Log. See Message log 
Logging messages. See Message log 
Logging off, 36-37, 87 
Logging on, 21, 88 
Logon domain. See Domains 

M 
Message log, 58 

changing the log file, 59-60, 85 
controlling message logging, 59-60, 85 
default, 58 
LANMAN\LOGS directory, 58-59 
MESSAGES.LOG file, 58 
reading the log, 58-59 
saving the log file, 59, 102 
turning off message logging, 60 

Message menu 
Aliases command, 61 

deleting an alias, 62 
Log messages to file command, 60 

changing the log file, 59 
Read message log file command, 58 
Send a typed message command, 56 

Messages 
LAN Manager 

assigning a language for a user, 151 



Netpopup service 
closing a message box, 58 

printing, 60 
reading 

message log, 55, 58 
with Netpopup running, 57 

receiving, 102 
for several users, 58 

sending, 56, 100 
broadcasting, 56 
to a workstation, 56 

Messenger service, 18, 55 
defined,55 
starting, 102 

Moving files. See Files 

N 
Net, 73 
Net access, 74-76 
Net config workstation, 77 
Net continue, 78 
Net continue [B], 134 
Net copy, 79-80 
Net help, 81-82 
Net help [B], 135 
Net helpmsg, 83 
Net load, 84 
Net log, 85-86 
Net logoff, 87 
Net logon, 88-89 

starting the workstation, 69 
Net move, 90 
Net name, 91-92 
Net name [B], 136 
Net password, 93-94 
Net pause, 95 
Net pause [B], 137 
Net print, 96-98 
Net print [B], 138-139 
Net save, 99 
Net send, 100-101 
Net start messenger, 102-103 
Net start netpopup, 104 
Net start workstation, 105-109 
Net start workstation [B], 140 
Net stop, 110 
Net time, 111 
Net use, 112-114 
Net use [B], 141-142 
Net view, 115-116 
Net who, 117-118 

Netpopup service, 19,57 
closing a message box, 58 
and message logging, 58 
starting, 104 
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Network products, working with others, 11, 50 
Non-LAN Manager servers, connecting to, 50 

p 
Passwords 

changing your password, 93 
logging on with, 88 
using with net commands, 70 

Passwords [B], using with net commands, 126 
Pausing a service. See Messenger service. Netpopup 
service. Workstation service. 
Permissions 

changing, 74 
defined,75 

Print jobs, 130 
defined,47 
deleting, 52 
finding job numbers, 48 
holding and releasing, 52 
restarting, 52 
viewing, 48 

Printer queues 
connecting to, 49, 112 
controlling queued jobs, 96 
defined,47 
disconnecting from, 54 
making a onetime connection, 51 
printing, using the LAN Manager Screen, 52 
viewing 

queue information, 48-49,96 
server's, 96 
status, 52 

with several printers, 48 
Printer queues [B] 

connecting to, 129 
disconnecting from, 131 
viewing status, 130 

Printers, shared 
defined,47 
See also Printer queues 

Printers, shared [B], 141 
Profiles, 18, 63 

creating, 99 
defined,18 
loading, 66, 84 
modifying, 65 
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Q 
Quitting LAN Manager. See LAN Manager 

R 
Reading messages. See Netpopup service. Messages. 
Message log. 
Resources, shared 

s 

defined,29 
viewing, 28-30 

Saving connections. See Connections. Profiles. 
Servers 

viewing, 28, 115 
viewing shared resources of, 115 

Services 
adjusting, 67 
continuing, 66-67, 78 
controlling, 66 
defined,18 
pausing, 66, 95 
stopping, 67, 110 
See also Messenger service. Netpopup service. 

Workstation service 
Shared. See Directories, shared. Printers, shared. 
Starting Workstation service. See Workstation 
service. 
Stopping services. See Messenger service. Netpopup 
service. Workstation service. 

T 
Time, synchronizing the workstation's clock, 111 

u 
Users 

viewing, 32 
with the net who command, 117 

v 
View menu 

Available resources command 
connecting to a printer queue, 49 
connecting to a shared directory, 40 
viewing resources, 29 
viewing shared directories, 39 

Printer queues command 
deleting a print job, 53 
viewing printer queues, 48 

U sed resources command 
connecting to a printer queue, 50 

connecting to a shared directory, 42 
disconnecting from a printer queue, 54 
disconnecting from a shared directory, 44 
viewing printer queue connections, 52 
viewing resource connections, 43 

Users on a server command 
viewing users with connections to a server, 30, 32 

Viewing. See Connections. Domains. Print jobs. 
Printer queues. Resources, shared. Servers. Users. 
Workstation. 

w ________________________ __ 
Workstation 

viewing configuration, 68 
viewing connections, 113 

Workstation [B] 
starting, 140 
viewing connections, 131 

Workstation domain. See Domains 
Workstation service, 18 

adjusting performance, 77, 105 
adjusting the display, 20 
Messenger service, 20 
Netpopup service, 20 
pausing, 37, 66 

effect on other services, 37 
starting, 19-21, 105 
starting with a batch program, 37 
stopping, 37, 110 
viewing configuration, 77 
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